# Table of Contents

- Introduction 1
- LUIS Setup 3
  - Ordering Hardware 4
  - How To Setup the LUIS 5
    - Setting Up a Standard LUIS 6
    - Setting Up a CAN Card Connection 10
    - Setting Up an Ethernet Connection 14
    - Changing the Sidecar 18
    - Adding Child Control Modules 20
    - Downloading New Firmware 24
    - ROM Booting 26
- The LUIS Graphical User Interface 29
  - Menu Bar 31
  - Toolbar 33
  - Waveform Gauges 34
  - Lamp Indicators 35
  - Throttle Ratiometric Dial 37
  - I/O Controls 38
    - Switches 39
    - Ratiometrics 40
    - Resistives 41
  - Closed Loop Controls 42
  - Other Windows and Dialog Boxes 44
- Configuring the LUIS GUI 49
  - The Component Configuration Window 50
    - The Menu Bar 51
    - The Toolbar 52
    - Panels 54
  - Creating Interpolation Tables 55
    - Creating an Interpolation Table 56
    - Importing an Interpolation Table 58
    - Deleting an Interpolation Table 60
  - Configuring Waveform Gauges 62
  - Configuring All Other Controls 70
  - Configuration Options 74
# Table of Contents, Continued

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The FMET Graphical Interface</td>
<td>77</td>
</tr>
<tr>
<td>How To Connect an FMET Box</td>
<td>78</td>
</tr>
<tr>
<td>The FMET Workflow</td>
<td>79</td>
</tr>
<tr>
<td>The FMET Interface</td>
<td>80</td>
</tr>
<tr>
<td>Menu</td>
<td>82</td>
</tr>
<tr>
<td>Toolbar</td>
<td>83</td>
</tr>
<tr>
<td>Fault Switches</td>
<td>84</td>
</tr>
<tr>
<td>Apply Fault Switches</td>
<td>85</td>
</tr>
<tr>
<td>Status Indicators</td>
<td>86</td>
</tr>
<tr>
<td>I/O Controls</td>
<td>88</td>
</tr>
<tr>
<td><strong>Appendix</strong></td>
<td>97</td>
</tr>
<tr>
<td>Waveforms</td>
<td>98</td>
</tr>
<tr>
<td>RS232 Channel Numbering</td>
<td>99</td>
</tr>
<tr>
<td>DAC Specific’s</td>
<td>101</td>
</tr>
<tr>
<td>Address Switch</td>
<td>102</td>
</tr>
<tr>
<td>Table Calibration</td>
<td>103</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>105</td>
</tr>
<tr>
<td>Connectors and Pinout</td>
<td>110</td>
</tr>
<tr>
<td>CAN Protocol</td>
<td>119</td>
</tr>
<tr>
<td>Multi-Parent Setup</td>
<td>128</td>
</tr>
</tbody>
</table>
# The Load Box User Interface System

## Introduction

The Load Box User Interface System, LUIS, is an engine simulator used to facilitate bench top engine control system hardware and software testing.

## LUIS Physical Description

The LUIS is a bench top, PC controlled load box with approximate dimensions of 18”x12”x4”.

![Image of LUIS](image_url)

## LUIS Features

The LUIS provides the following features:

- Open and Closed Loop Engine Speed Simulation
- Integrated GarTech Arbitrary Waveform Generator
- Engine Speed (ESS), Engine Position (EPS) and up to 6 Additional Frequency Outputs
- 16 Resistive A/D Outputs
- 16 Ratiometric A/D Outputs
- 24 Active Low Switches
- 6 Individually Configurable High/Low Side Switch Outputs
- LUIS PC Application Allowing User Complete Control Over I/O Setup
- Creation of Configuration Files To Setup I/O for Specific Tests
- Control of Multiple Boxes by a single PC Application for Seamless Integration Testing of Single Engine systems with Multiple Engine Control Modules (ECM’s)
- Acceptance of CAN Commands using the J1939 Proprietary PGN
- FMET Box for Failure Mode Effects Testing
Chapter 1 - LUIS Setup

Overview

LUIS Hardware

The LUIS has a main, parent, control module that can be connected to the PC via a CAN card or an Ethernet connection. Up to 2 additional child control modules can be added for testing a single engine system with multiple ECM’s. A sidecar is also available allowing for injector loads and application specific high current loads.

This diagram illustrates the back panel of the standard LUIS.

In This Section

This table outlines the topics covered in this section.

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ordering Hardware</td>
<td>4</td>
</tr>
<tr>
<td>How To Setup the LUIS</td>
<td>5</td>
</tr>
</tbody>
</table>
Section 1 - Ordering Hardware

Ordering Hardware

<table>
<thead>
<tr>
<th>GarTech Contact Information</th>
<th>All hardware can be ordered from GarTech Enterprises, Inc.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Gartech Enterprises, Inc.</td>
</tr>
<tr>
<td></td>
<td>3037 W. State Road 256</td>
</tr>
<tr>
<td></td>
<td>Austin, IN 47102</td>
</tr>
<tr>
<td></td>
<td>812-794-4796</td>
</tr>
<tr>
<td></td>
<td><a href="http://www.gartechenterprises.com">www.gartechenterprises.com</a></td>
</tr>
<tr>
<td></td>
<td><a href="mailto:info@gartechenterprises.com">info@gartechenterprises.com</a></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>GarTech Part Numbers</th>
<th>This table gives the part number and descriptions for the LUIS hardware.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part Number</td>
<td>Description</td>
</tr>
<tr>
<td>G00391-00</td>
<td>LUIS PC Controller with 10” LC Monitor, Keyboard, Mouse and CAN Card</td>
</tr>
<tr>
<td>G00392-04</td>
<td>LUIS Main (Parent) Control Module with LED front panel</td>
</tr>
<tr>
<td>G00726-10</td>
<td>LUIS Sidecar with Injector Loads and LED’s</td>
</tr>
<tr>
<td>G00393-02</td>
<td>LUIS Child Control Module (for multiple ECM systems) with sidecar</td>
</tr>
<tr>
<td>G012191-00</td>
<td>FMET Box</td>
</tr>
</tbody>
</table>

Section 2 - How To Setup the LUIS

Overview

Introduction
The setup of the LUIS software is completed by downloading the software and following the installation wizard. The setup of the LUIS hardware depends on the PC connection as well as the optional equipment added to the standard control module.

In This Section
This table outlines the topics found in this section.

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting Up a Standard LUIS</td>
<td>5</td>
</tr>
<tr>
<td>Setting Up a CAN Card Connection</td>
<td>6</td>
</tr>
<tr>
<td>Setting Up an Ethernet Connection</td>
<td>14</td>
</tr>
<tr>
<td>Changing the Sidecar</td>
<td>18</td>
</tr>
<tr>
<td>Adding Child Control Modules</td>
<td>20</td>
</tr>
<tr>
<td>Downloading New Firmware</td>
<td>24</td>
</tr>
<tr>
<td>ROM Booting</td>
<td>26</td>
</tr>
</tbody>
</table>
Setting Up a Standard LUIS

Introduction
The LUIS can communicate with the PC through a CAN Card or Ethernet connection. However, the basic hardware setup is the same.

Hardware Needed
To setup the LUIS, the following hardware is required.

- Standard LUIS
- PC
- Control Module
- Wiring Harness
- Control Module Power Connector
- DC Power Cable
- DC Power Supply
- AC Power Cable
- J1939 Cable

Setting Up the Hardware
This table outlines the physical connections required to setup the hardware to run a standard LUIS.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Using the J1939 cable, connect the Public J1939 port on the back of the LUIS to the right hand Public J1939 port on the back of the Sidecar.</td>
</tr>
<tr>
<td>3</td>
<td>Install the Control Module on the pegs located on the top of the LUIS.</td>
</tr>
<tr>
<td>4</td>
<td>Using the appropriate Wiring Harness, connect the Control Module to the LUIS using the ports on top of the box as well as the Injector Connector on the back of the Sidecar.</td>
</tr>
<tr>
<td>5</td>
<td>Using the Control Module Power Connector, connect the Control Module to the Unswitched Power Out port on the back of the LUIS.</td>
</tr>
</tbody>
</table>

Continued on next page
Setting Up a Standard LUIS, Continued

**J1939 Cable Connections**
This picture illustrates the J1939 Cable connections between the LUIS and the Sidecar.

**Control Module Connections**
This picture illustrates the installed Control Module with the Wiring Harness and Power Connector.
Setting Up a Standard LUIS, Continued

Setting Up the Hardware, Continued

This table continues to outline the physical connections required to setup the hardware to run a standard LUIS.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>Using the DC Power Cable, connect the LUIS to the DC Power Supply using the Unswitched Power In ports on the back of the LUIS.</td>
</tr>
<tr>
<td>7</td>
<td>Using the AC Power Cable, plug the LUIS in.</td>
</tr>
<tr>
<td>8</td>
<td>To complete the connection to the PC, please go to the appropriate setup section for CAN Card or Ethernet.</td>
</tr>
</tbody>
</table>

Continued on next page
Setting Up a Standard LUIS, Continued

**DC Power Connections**
This picture illustrates the DC Power connection between the LUIS and the DC power supply.

![DC Power Connection](image1)

**AC Power Supply**
This picture illustrates the AC power connection.

![AC Power Connection](image2)
Setting Up a CAN Card Connection

Setting Up a CAN Card Connection

Introduction

The LUIS can communicate with a PC via a CAN Card.

Hardware Required

To connect the LUIS with a CAN card, the following hardware is required.

- CAN Card or other Peak Adapter
- CAN Card Cable with 120 ohm terminating resistor across CAN High and CAN Low at both ends

Setting Up a CAN Card Connection

This table outlines the steps required to setup the LUIS hardware and software to run via a CAN Card connection.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | After completing the setup for a standard LUIS, use the CAN Cable to connect the PC CAN Card to the left hand Public J1939 port on the Sidecar.  
Note: The CAN Cable must have a 120 ohm terminating resistor across CAN High and CAN Low at both ends. |
| 2    | Power up both the PC and LUIS. |
| 3    | Open the Windows Control Panel from the Start button. |
| 4    | DoubleClick the CAN Hardware icon to view the CAN settings. Verify that the correct CAN device type is selected. Once the device type is correct, close the dialog box as well as the Control Panel. |
| 5    | Start the LUIS software. |
| 6    | From the Hardware menu, Select the Select Adapter option. The Peak CAN option should be selected. If it is not selected, from the adapter options Select Peak CAN.  
Note: If changing the adapter type a message dialog box displays indicating that the LUIS software must be restarted for the change to take effect. Click <Yes> to restart. The user must restart LUIS. |

Continued on next page
Setting Up a CAN Card Connection, Continued

**CAN Card Connection**

This picture illustrates the CAN Cable connection between the PC and the LUIS.

---

**CAN Cable**

---

**CAN Hardware Options**

This is an example of the CAN Hardware options available from the Windows Control Panel.

---

Continued on next page
**Setting Up a CAN Card Connection, Continued**

This table continues to outline the steps required to setup the LUIS hardware and software to run via a CAN Card connection.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 7    | From the **Hardware** menu, **Select** the **Peak Adapter** option. From the **Peak Adapter** options, **Select** **Set Net Name**.  
**Result:** The **Net Name** dialog box displays. |
| 8    | The **Current Net Name** field displays the net name currently in use. If the net name is not correct, **Type** the correct name in the field and **Click** **<OK>**.  
**Note:** If changing the net name a message box displays indicating that the LUIS software must be restarted for the change to take effect. **Click** **<Yes>** to restart. |
| 9    | The LUIS hardware and software is installed and ready to run communicating through the CAN Card connection. |

*Continued on next page*
Net Name Dialog Box

This is an example of the *Net Name* dialog box.

![Net Name Dialog Box](image_url)
Setting Up an Ethernet Connection

Introduction

The LUIS can communicate with the PC through an Ethernet connection.

Hardware Needed

To connect the LUIS through the Ethernet, the following hardware is required.

- Optional LUIS Ethernet Card
- Crossover Ethernet Cable or Hub and Ethernet Cables

Setting Up an Ethernet Connection

This table outlines the steps for setting up the LUIS hardware and software to run via an Ethernet connection.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | After completing the setup for a standard LUIS, use the appropriate Ethernet cable to connect the PC to the LUIS.  
      | Note: To connect directly, a crossover cable must be used. |
| 2    | Power up both the PC and LUIS. |
| 3    | Start the LUIS software. |
| 4    | From the **Hardware** menu, **Select** the **Select Adapter** option.  
      | From the **Adapter** options, **Select Ethernet**.  
      | **Result:** The message dialog box displays indicating that the LUIS software must be restarted for the change to take effect.  
      | **Click <Yes>** to restart. |
| 5    | Once LUIS has restarted, from the **Hardware** menu, **Select** the **Ethernet** option.  
      | From the **Ethernet** options, **Select Configure**.  
      | **Result:** The **Ethernet Configuration** window displays. |
| 6    | In the **F/W Version** field, the current firmware version displays.  
      | **Note:** This firmware version applies only to the TCP/IP add-on card. It is not the same as the LUIS firmware |

*Continued on next page*
Setting Up an Ethernet Connection, Continued

This picture illustrates the Ethernet connection between the PC and the LUIS.

This graphic is an example of the Ethernet Configuration window.
This table continues to outline the steps for setting up the LUIS hardware and software to run via an Ethernet connection.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 7    | In the Search for Devices panel, Click the <Search> button.  
**Result:** The MACID Addresses for all local devices display in the Detected Devices field.  
**Note:** A direct IP Search can be completed to find an IP address outside the local devices by Selecting the Direct IP Search checkbox, entering the IP Address and Clicking <Search>. |
| 8    | Select the MACID Address for the Ethernet card in the LUIS box from the list.  
**Note:** The Ethernet card should be labeled with its MACID Address. |
| 9    | The fields on the window display the information for the selected Ethernet card. |
| 10   | Make any changes required.  
**Note:** Changes cannot be made if the card is in DHCP mode. |
| 11   | Once the Ethernet settings are correct, Click the <Set> button. |
| 12   | To close the window, Click the <Exit> button. |
| 13   | To begin communicating, from the Hardware menu, Select Ethernet and then the Connect/Disconnect option.  
**Result:** The LUIS hardware and software is installed and is communicating through the Ethernet connection. |

*Continued on next page*
Setting Up an Ethernet Connection, Continued

This graphic is an example of the **Ethernet Configuration** window.
Changing a Sidecar

**Introduction**

Sidecars can be added to the parent LUIS to allow for injector loads and application specific high current loads. Different Sidecars are needed depending on the loads required.

**Changing a Sidecar**

This table outlines the steps for changing a Sidecar.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Power down the LUIS unit.</td>
</tr>
<tr>
<td>2</td>
<td>Disconnect all the cables connected to the back of the Sidecar.</td>
</tr>
</tbody>
</table>
| 3    | Unscrew the two thumbscrews holding the Sidecar to the Load Box.  
       | **Note:** There is one screw on the front of the unit and one on the back. |
| 4    | Carefully pull the sidecar away from the Load Box. |
| 5    | Disconnect the internal cable between the Sidecar and the Load Box. |
| 6    | Connect the internal cable between the new Sidecar and the Load Box. |
| 7    | Carefully push the Sidecar to the load box. |
| 8    | Screw in the two thumbscrews to attach the Sidecar to the Load Box. |
| 9    | Connect all the cables to the back of the new Sidecar. |
| 10   | Power up the LUIS. |
| 11   | The new loads can now be added to the configuration file in the LUIS GUI. |

*Continued on next page*
Changing a Sidecar, Continued

**Sidecar Assembly/Disassembly**

This picture illustrates the Sidecar detached from the Load Box.

**Internal Connection**

This picture illustrates the internal connection between the Sidecar and the Load Box.
Adding Child Modules

Addition of Child Modules

Up to two child modules can be added to the LUIS for testing a single engine system with multiple ECM’s.

Hardware Required

This following hardware is required when adding a child module.

- ECM
- Child Load Box
- Parent/Child J1939 Cables
- Parent/Child Private CAN Bus Connector Cables
- Parent/Child LUIS Bus Connector Cables
- Parent/Child Control Module Power Connector

Adding Child Module

This table outlines the steps for adding child modules to the LUIS.

Note: A Parent/Child stack can be ordered directly from GarTech. This unit is shipped already stacked and connected. When this item arrives, this table can be used to ensure that all of the cables are connected as expected and nothing was loosened during shipping.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | Setup the parent module as a standard LUIS.  
      | Note: For more information, see Setting Up a Standard LUIS. |
| 2    | Install the Control Module on the pegs located on the top of the Child Load Box. |
| 3    | Using the appropriate wiring harness, connect the Control Module to the Child Load Box using the ports on top of the box. |
| 4    | Replace the J1939 cable between the Sidecar and Parent Load Box with the Parent/Child J1939 cable. This cable plugs into the right hand Public J1939 port on the Parent Side Car and into the Public J1939 port on each Load Box in the setup. |

Continued on next page
Adding Child Modules, Continued

Public CAN Connections

This picture illustrates the Public J1939 CAN Connections.

Continued on next page
Adding Child Modules, Continued

This table outlines the steps for adding child modules to the LUIS.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Replace the Control Module Power Connector with the Parent/Child Control Module Power Connector. Connect this cable to the Unswitched Power Out port on the back of each Load Box.</td>
</tr>
<tr>
<td>6</td>
<td>Make the private CAN connection by plugging the Parent/Child CAN Connector into the Private J1939 port on each Load Box in the setup.</td>
</tr>
<tr>
<td>7</td>
<td>Connect the LUIS Bus by plugging the Parent/Child LUIS Bus Connector into the LUIS Bus port on the back of each Load Box.</td>
</tr>
</tbody>
</table>

Continued on next page
Adding Child Modules, Continued

Control Module Power Connections
This picture illustrates the Control Module Power Connections.

Private CAN Connections
This picture illustrates the Private CAN Connections.

LUIS Bus Connections
This picture illustrates the LUIS Bus connections.
Downloading New Firmware

Introduction

Firmware is an instruction set stored in the ROM. Parent and Child boxes have same firmware. The Wavemaker and FMET Box have different Firmware.

Downloading Firmware

This table outlines the steps for downloading firmware.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Before downloading firmware, ensure that both the VBatt and Keyswitch are off and that Engine Speed is set to 0.</td>
</tr>
<tr>
<td>2</td>
<td>Close any datalink tools running on the PC.</td>
</tr>
</tbody>
</table>
| 3    | From the Hardware menu, Select the Download Firmware option.  
**Result:** The Firmware window displays. |
| 4    | In the Destination Device section, Select the hardware to which the firmware will be downloaded. |
| 5    | Click the <Select Binary File> button. On the Open dialog box, Browse and Select the correct firmware file, and Click <Open>.  
**Note:** To avoid errors, the firmware to download should be resident on the local machine rather than on a network drive. |
| 6    | Once the firmware file has been selected, Click the <Download> button.  
**Troubleshooting:** If the download fails to complete or errors occur, the LUIS must be ROM booted to be able to continue. See **ROM Booting** in this section.  
**Result:** The firmware is downloaded to the selected device. As the download occurs, messages display in the Firmware File field. |
| 7    | Once the download is complete, Click the <Exit> button to close the dialog box.  
**Note:** If new firmware was downloaded to the Wavemaker, the power on the LUIS box must be cycled before the download will be complete. |
This graphic is an example of the **Firmware** window.
ROM Booting

Introduction

ROM Booting is a troubleshooting process used to reset the hardware after a failed download or if communications stop between the LUIS and the PC.

ROM Booting

This table outlines the steps for ROM Booting.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Shut down the LUIS box.</td>
</tr>
</tbody>
</table>
| 2    | In the LUIS software, from the **Hardware** menu **Select** the **Download Firmware** option.  
**Result**: The **Firmware** dialog box displays. |
| 3    | **Click** the `<Select Binary File>` button. On the **Open** dialog box, find and select the appropriate firmware file.  
**Note**: The firmware should be resident on the PC not on a network drive. |
| 4    | **Click** the `<Download>` button.  
**Result**: The “Do Not Turn Unit Off” message displays. |
| 5    | A series of messages will display. When the “Resetting Loadbox” message displays, turn the LUIS box power on.  
**Note**: The LUIS box must be powered on within about 2 seconds of the message or the ROM Boot will fail. If this happens, try again. |
| 6    | The firmware will be downloaded to all devices simultaneously except the Wavemaker. When the download is complete the “Firmware Update Complete” message displays. |
| 7    | Communication should now be restored between the PC and the LUIS Box. |
| 8    | Since the Wavemaker uses different firmware, it must be downloaded via the standard **Download Firmware** procedure earlier in this section. Until this download is complete, the firmware version will display as 99.99. |

*Continued on next page*
ROM Booting, Continued

**Firmware Dialog Box**

This graphic illustrates the “Resetting Loadbox” message on the **Firmware** dialog box.

![Firmware Dialog Box](image)
Chapter 2 – The LUIS Graphical User Interface

Overview

Introduction
The LUIS comes with a graphical user interface for controlling all outputs as well as for setting up closed loop controls. The LUIS GUI is made up of a menu system, toolbar, waveform gauges, lamp indicators, throttle dial, I/O controls, and closed loop controls.

LUIS GUI

Basic Environment
This diagram and table describe the basic LUIS GUI environment.

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Menu Bar</td>
</tr>
<tr>
<td>2 Toolbar</td>
</tr>
<tr>
<td>3 Waveform Gauges</td>
</tr>
<tr>
<td>4 Lamp Indicators</td>
</tr>
<tr>
<td>5 Throttle Ratiometric Dial</td>
</tr>
<tr>
<td>6 I/O Controls</td>
</tr>
<tr>
<td>7 Closed Loop Controls</td>
</tr>
</tbody>
</table>

*Continued on next page*
**Overview, Continued**

**In This Section**
This table outlines the topics covered in this section.

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Bar</td>
<td>31</td>
</tr>
<tr>
<td>Toolbar</td>
<td>33</td>
</tr>
<tr>
<td>Waveform Gauges</td>
<td>34</td>
</tr>
<tr>
<td>Lamp Indicators</td>
<td>35</td>
</tr>
<tr>
<td>Throttle Ratiometric Dial</td>
<td>37</td>
</tr>
<tr>
<td>I/O Controls</td>
<td>38</td>
</tr>
<tr>
<td>Closed Loop Controls</td>
<td>42</td>
</tr>
<tr>
<td>Other Windows and Dialog Boxes</td>
<td>44</td>
</tr>
</tbody>
</table>
## Section 1 - Menu Bar

### Menu Bar

This table outlines the menus that are available as well as the options available on each menu.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td><strong>Open Configuration</strong></td>
<td>Opens a saved configuration and applies it to the GUI.</td>
</tr>
<tr>
<td></td>
<td><strong>Save Configuration As…</strong></td>
<td>Save the current GUI configuration to be opened later.</td>
</tr>
<tr>
<td></td>
<td><strong>Exit</strong></td>
<td>Exit the LUIS GUI.</td>
</tr>
<tr>
<td><strong>Operation</strong></td>
<td><strong>Reset</strong></td>
<td>Resets controls to their default positions.</td>
</tr>
<tr>
<td></td>
<td><strong>Front Panel Layout</strong></td>
<td>Opens the <em>Front Panel Functions</em> dialog box where a replica of the Parent Controller front panel can be customized.</td>
</tr>
<tr>
<td></td>
<td><strong>Set Current As Defaults</strong></td>
<td>Sets the current settings as the defaults for the configuration.</td>
</tr>
<tr>
<td></td>
<td><strong>Configuration Panel</strong></td>
<td>Opens the <em>Component Configuration</em> window to setup the GUI.</td>
</tr>
<tr>
<td></td>
<td><strong>Data Player</strong></td>
<td>Opens the <em>Data Player</em> window to configure the data player.</td>
</tr>
<tr>
<td><strong>Hardware</strong></td>
<td><strong>Download Firmware</strong></td>
<td>Opens the <em>Firmware</em> dialog box to download new firmware.</td>
</tr>
<tr>
<td></td>
<td><strong>Select Adapter</strong></td>
<td>Sets the adapter type to <em>Ethernet</em> or <em>Peak CAN</em>.</td>
</tr>
</tbody>
</table>
This table continues to outline the menus that are available as well as the options available on each menu.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hardware</strong></td>
<td><em>Peak Adapter</em></td>
<td>Gives the option for setting the New Name.</td>
</tr>
<tr>
<td>(Continued)</td>
<td><em>Ethernet</em></td>
<td>Allows the Ethernet to be configured or connected/disconnected.</td>
</tr>
<tr>
<td></td>
<td><em>Calibrate</em></td>
<td>Opens the <em>Calibrate Unit</em> dialog box so the unit can be calibrated with the ECM for accurate temperature values.</td>
</tr>
<tr>
<td><strong>Help</strong></td>
<td><em>Contents</em></td>
<td>Opens the on-line help.</td>
</tr>
<tr>
<td></td>
<td><em>About</em></td>
<td>Opens the <em>About</em> dialog box to display the version information.</td>
</tr>
<tr>
<td></td>
<td><em>GarTech on the Web</em></td>
<td>Opens the GarTech website in the default browser.</td>
</tr>
</tbody>
</table>
Section 2 – Toolbar

Introduction

The toolbar provides quick access to many of the often used menu items.

Toolbar

This graphic and table outlines the options available from the toolbar.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Open Configuration</td>
</tr>
<tr>
<td></td>
<td>Save Configuration</td>
</tr>
<tr>
<td></td>
<td>Reset Switches</td>
</tr>
<tr>
<td></td>
<td>Reset Ratiometrics</td>
</tr>
<tr>
<td></td>
<td>Reset Gauges</td>
</tr>
<tr>
<td></td>
<td>Reset Resistive</td>
</tr>
<tr>
<td></td>
<td>Reset Rotary Switches</td>
</tr>
<tr>
<td></td>
<td>Download Firmware</td>
</tr>
<tr>
<td></td>
<td>Set Net Name</td>
</tr>
<tr>
<td></td>
<td>Configure Ethernet</td>
</tr>
<tr>
<td></td>
<td>Connect/Disconnect Ethernet</td>
</tr>
<tr>
<td></td>
<td>Component Configuration</td>
</tr>
<tr>
<td></td>
<td>Front LUIS Panel Layout</td>
</tr>
<tr>
<td></td>
<td>Set Current as Default</td>
</tr>
<tr>
<td></td>
<td>Reset Communication Interface</td>
</tr>
<tr>
<td></td>
<td>Data Player</td>
</tr>
</tbody>
</table>
Section 3 - Waveform Gauges

Waveform Gauges

Introduction
The LUIS has the GarTech Arbitrary Waveform Generator integrated into the system. The eight waveform gauges provide the ability to monitor and manipulate these waveforms.

Waveform Gauges
The eight waveform gauges are found on two tabs labeled Primary and Secondary. These gauges are setup on the Gauge section of the Component Configuration window. When configuring the gauges the card type, arbitrary or digital, and input and output types must be known. The teeth per revolution, cycles per revolution, ramp rate and PWM heartbeat frequency must also be known. There is also an option to sync waveforms together, however this does nothing to the gauge.

Waveform Gauges Location
This graphic illustrates the waveform gauges and their location on the LUIS main window.
Section 4 - Lamp Indicators

Lamp Indicators

Introduction

There are two rows of lamp indicators on the LUIS GUI. The top row, Load Box Status, provides feedback on the controllers, sidecar and wavemaker. The second row, Front Panel Lamps, mirrors the lamps on the front of the Parent controller.

Load Box Status

The top row of indicator lamps are labeled Load Box Status. These lamps are illuminated green to indicate that the various hardware pieces are connected and communicating. If a lamp is not illuminated green, that piece of equipment is either disconnected or not communicating.

If Load Box Status lamps indicate that communication has been lost, and communication cannot be restarted by rebooting, follow the Rom Booting procedure earlier in this document to recover communication.

From left to right the indicators show Parent Controller, Child 1, Child 2, Sidecar, and Wavemaker. When the cursor is held over these lamps, a pop-up displays to indicate the current state of the hardware as well as the current firmware version.

Front Panel Lamps

The second row of indicator lamps are labeled Front Panel Lamps. These lamps mirror the lamps on the front of the Parent Controller. This is particularly useful in setups where the controller is not easily in sight. These lamps can be named for easy reference using the Front Panel Layout option on the Hardware menu. When the cursor is held over these lamps, a pop-up displays the name given to that lamp on the Front Panel Layout dialog box.

Continued on next page
Lamp Indicators, Continued

<table>
<thead>
<tr>
<th>Indicator Lamps</th>
<th>Location</th>
</tr>
</thead>
</table>

This graphic illustrates the indicator lamps and their location on the LUIS GUI.
## Section 5 - Throttle Ratiometric Dial

### Throttle Ratiometric Dial

<table>
<thead>
<tr>
<th><strong>Introduction</strong></th>
<th>On the LUIS GUI there is one ratiometric dial on the front panel.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Throttle Ratiometric Dial</strong></td>
<td>The ratiometric dial on the front panel is automatically configured to be Throttle. This assignment can be changed when configuring the panel. When changing, keep in mind that the Throttle is used for Auto IVS functionality, the IVS switches trigger off of their set switch point and gets its value from this pot knob.</td>
</tr>
<tr>
<td><strong>Throttle Ratiometric Dial Location</strong></td>
<td>This graphic illustrates the Throttle Ratiometric Dial and it’s location on the LUIS GUI.</td>
</tr>
</tbody>
</table>

![Throttle Ratiometric Dial Location](image-url)
Section 6 - I/O Controls

I/O Controls

Introduction
All the I/O controls are found on seven tabs categorized by control type: switch, ratiometric, and resistive. All control names, values, units, and scales are setup on the Configuration Panel window.

I/O Controls Location
The different I/O Controls are accessed by pressing the tabs. This diagram illustrates the I/O controls section and its location on the LUIS GUI.

In This Section
This table outlines the topics covered in this section.

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switches</td>
<td>39</td>
</tr>
<tr>
<td>Ratiometrics</td>
<td>40</td>
</tr>
<tr>
<td>Resistives</td>
<td>41</td>
</tr>
</tbody>
</table>
Switches

Introduction

The first two tabs in the I/O controls section of the GUI provide 32 position switches and 3 rotary switches. The first switch is defaulted to Keyswitch.

Setting Positions

The two position switches are either in the ON position, which is indicated by the top of the switch being depressed and the switch name being displayed in red, or the OFF position, which is indicated by the bottom of the switch being depressed and the switch name being displayed in black.

The rotary switches are in one of three positions as indicated by the top of the yellow dial as well as displaying the position number in blue.
## Ratiometrics

### Introduction
The third and fourth tabs in the I/O controls section of the GUI provide gauges for 16 ratiometric channels.

### Setting Values
The ratiometrics can be controlled by the dial, the slider, the increment/decrement arrows, or by typing in the value field.

![Ratiometric Gauge](image)

### Ratiometric Units
Ratiometrics can be displayed in millivolts or counts. The units are controlled by the V or C button in the lower right hand corner. The unit displayed on the button is the current unit being used.
Resistives

Introduction
The fifth, sixth, and seventh tabs in the I/O Controls section of the LUIS GUI provide sliders for 24 resistive channels.

Setting Values
The resistive controls can be controlled by the slider or the increment/decrement arrows.
Section 7 - Closed Loop Controls

Closed Loop Controls

Introduction

The LUIS can be set to run closed loop engine speed control. In this mode the engine speed signal generated by the load box responds similarly to an actual engine. J1939 public broadcast must be running in the ECM to run in closed loop mode.

Closed Loop Controls

The last tab in the I/O controls section, labeled Speed/Throttle, is the closed loop controls section. Here the engine model and throttle pedal idle validation is setup for closed loop control.

Engine Model

In the engine model section, the percent load and gain adjust are set using the sliders. The loop is set to closed using the Closed/Open switch. The start switch is used to start the closed loop control, and the reset switch set the model back to zero load/rpm.

Continued on next page
The throttle idle validation section is used to simulate idle validation. Idle can be set to toggle automatically based on switch points in counts or manually.

When the Auto IVS switch is set to On, the On Idle and Off Idle switches turn on and off automatically based on the values entered for the Switch Points in Counts fields. The Switch Point in Counts values apply to the Throttle ratiometric. The On Idle and Off Idle lamps light to indicate the present state.

When setting the throttle pedal idle validation manually, click the On Idle and Off Idle switches when required.
Section 8 - Other Windows and Dialog Boxes

Other Windows and Dialog Boxes

Introduction

The LUIS GUI provides other windows and dialog boxes for configuring and other actions.

Front Panel Window

The Front Panel window is opened from the Operation menu. It displays a picture of the front of the Parent Controller. On this window, the generic labels can be replaced with meaningful names. It can be printed, by pressing the printer icon, and used as a map of the controller.

Configuration

The Component Configuration window is used to configure all the I/O controls on the main screen. This window is available from the Equipment menu.

Continued on next page
Firmware Dialog Box

This Firmware dialog box is used to download new firmware to the hardware. This dialog box is available from the Hardware menu.

Net Name Dialog Box

The Net Name dialog box is used to set the net name for the CAN connection. This dialog box is accessed through the Hardware menu.

Ethernet Configuration Dialog Box

The Ethernet Configuration dialog box is used to configure the Ethernet connection. It is accessed through the Hardware menu.

Continued on next page
**Other Windows and Dialog Boxes, Continued**

**Connect to Hardware Dialog Box**

The *Connect to Hardware* dialog box is used to connect to and disconnect from the Ethernet. This dialog box is accessed through the *Hardware* menu.

![Connect to Hardware Dialog Box](image)

**Calibrate Unit Dialog Box**

The *Calibrate Unit* dialog box is used to calibrate hardware to the ECM to ensure accurate temperature readings. This dialog box is accessed through the *Hardware* menu.

![Calibrate Unit Dialog Box](image)
Other Windows and Dialog Boxes, Continued

**Data Player Dialog Box**

The *Data Player* dialog box is used to load and playback CSV data files. This dialog box is accessed through the *Operation* menu.

![Data Player Dialog Box](image)

© 2008 GarTech Enterprises, Inc.                       Prepared by Logos Ltd. Version 08DEC08
Chapter 3 – Configuring the LUIS GUI

Overview

Introduction
Each of the controls on the LUIS GUI can be configured. They can be named as well as having defaults, units, and minimum/maximum values set. They can be interlocked with other controls, and they can be removed from the display. All configuration takes place on the Component Configuration window.

In This Section
This table outlines the topics covered in this chapter.

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Component Configuration Window</td>
<td>50</td>
</tr>
<tr>
<td>Interpolation Tables</td>
<td>55</td>
</tr>
<tr>
<td>Configuring Waveform Gauges</td>
<td>62</td>
</tr>
<tr>
<td>Configuring All Other Controls</td>
<td>70</td>
</tr>
<tr>
<td>Configuration Options</td>
<td>74</td>
</tr>
</tbody>
</table>
Section 1 – The Component Configuration Window

The Component Configuration Window

Introduction

The Component Configuration window is used to configure the LUIS GUI. The window has its own menu and toolbars unlike those on the main window.

The Component Configuration Window

This graphic and table describe the Component Configuration window.

<table>
<thead>
<tr>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 Menu Bar</td>
</tr>
<tr>
<td>2 Toolbar</td>
</tr>
<tr>
<td>3 Panels</td>
</tr>
</tbody>
</table>

In This Section

This table outlines the topics covered in this section.

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Menu Bar</td>
<td>51</td>
</tr>
<tr>
<td>The Toolbar</td>
<td>52</td>
</tr>
<tr>
<td>Panels</td>
<td>54</td>
</tr>
</tbody>
</table>
# The Menu Bar

This table outlines the menus and their options available on the **Component Configuration** window.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>New Configuration</em></td>
<td>Resets all the fields for a new configuration.</td>
</tr>
<tr>
<td></td>
<td><em>Open Configuration</em></td>
<td>Opens the <em>Open</em> dialog box where an existing configuration can be found and loaded.</td>
</tr>
<tr>
<td></td>
<td><em>Save Configuration As</em></td>
<td>Opens the <em>Save As</em> dialog box so the current configuration can be saved under a new name.</td>
</tr>
<tr>
<td></td>
<td><em>Print</em></td>
<td>Opens the <em>Print Preview</em> window from which the configuration can be printed.</td>
</tr>
<tr>
<td></td>
<td><em>Exit</em></td>
<td>Closes the <strong>Component Configuration</strong> window.</td>
</tr>
<tr>
<td><strong>Component</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><em>Switch</em></td>
<td>Displays the switch components in the <strong>Panels</strong> section of the window.</td>
</tr>
<tr>
<td></td>
<td><em>Pot Knob</em></td>
<td>Displays the pot knob components in the <strong>Panels</strong> section of the window.</td>
</tr>
<tr>
<td></td>
<td><em>Gauge</em></td>
<td>Displays the gauge components in the <strong>Panels</strong> section of the window.</td>
</tr>
<tr>
<td></td>
<td><em>Slider Rotary</em></td>
<td>Displays the slider rotary components in the <strong>Panels</strong> section of the window.</td>
</tr>
</tbody>
</table>
## The Menu Bar, Continued

<table>
<thead>
<tr>
<th>Menu</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Tools</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Apply</strong></td>
<td></td>
<td>Apply the configuration to the Main Panel.</td>
</tr>
<tr>
<td><strong>Tables</strong></td>
<td></td>
<td>Opens the <strong>Tables</strong> dialog box where tables can be added or modified.</td>
</tr>
<tr>
<td><strong>Configuration Options</strong></td>
<td></td>
<td>Opens the <strong>Options</strong> dialog box where Tabs and Engine Model options can be set.</td>
</tr>
<tr>
<td><strong>Move Up</strong></td>
<td></td>
<td>Moves the selected entry up the list.</td>
</tr>
<tr>
<td><strong>Move Down</strong></td>
<td></td>
<td>Moves the selected entry down the list.</td>
</tr>
</tbody>
</table>
The Toolbar

This graphic and table describe the icons available on the Component Configuration window.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>📄</td>
<td>New configuration</td>
</tr>
<tr>
<td>📜</td>
<td>Open a new configuration</td>
</tr>
<tr>
<td>📞</td>
<td>Save the configuration</td>
</tr>
<tr>
<td>📑</td>
<td>Print the configuration</td>
</tr>
<tr>
<td>💾</td>
<td>Configure Switches</td>
</tr>
<tr>
<td>🔁</td>
<td>Configure Pot Knobs</td>
</tr>
<tr>
<td>🎟</td>
<td>Configure Gauges</td>
</tr>
<tr>
<td>🔻</td>
<td>Configure Sliders</td>
</tr>
<tr>
<td>🔮</td>
<td>Configure Rotary Knobs</td>
</tr>
<tr>
<td>📊</td>
<td>Interpolation Tables</td>
</tr>
<tr>
<td>🎁</td>
<td>Configuration Options</td>
</tr>
<tr>
<td>🎁</td>
<td>Move Entry Up</td>
</tr>
<tr>
<td>🎁</td>
<td>Move Entry Down</td>
</tr>
<tr>
<td>✅</td>
<td>Apply configuration</td>
</tr>
</tbody>
</table>
Panels

The Panels portion of the Component Configuration window is where the configuration elements display.

The panels for switches, pot knobs, sliders, and rotary are identical except for the number of channels permitted. The panel for gauges has an upper portion identical to the other controls as well as a lower portion for configuring the waveform channels.

There is also a panel for managing interpolation tables, and one additional panel for configuration options. The Configuration Options panel allows the user to determine the names and visibility of the tabs on the main window.
Section 2 –Interpolation Tables

Overview

Introduction
Some of the components controlled by the LUIS require an interpolation table to match the engineering unit that is on the gauge to a counts value. For example, 32 PSI is 500 counts, which is a specific voltage that LUIS outputs.

In This Section
This table outlines the topics covered in this section.

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating an Interpolation Table</td>
<td>56</td>
</tr>
<tr>
<td>Importing an Interpolation Table</td>
<td>58</td>
</tr>
<tr>
<td>Deleting an Interpolation Table</td>
<td>60</td>
</tr>
</tbody>
</table>
Creating an Interpolation Table

Introduction

Interpolation tables can be created from the Table panel in the Component Configuration window. The data can be entered manually, or cut and pasted from another application such as Microsoft Excel.

Creating an Interpolation Table

This table outlines the steps for creating an interpolation table.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | From the Operations menu, Select the Configuration Panel option.  
      Result: The Component Configuration window displays. |
| 2    | On the Menu Bar, Click the Tables icon.  
      Result: The Table panel displays in the Component Configuration window. |
| 3    | If any tables have already been added to the configuration, they display in the Table Name box. The selected table’s contents display in the table on the left hand side of the panel, and its general setup information displays in the fields below the Table Name box. |
| 4    | To add a new table directly in the LUIS GUI, Click the <Add Table> button.  
      Result: The Table Name dialog box displays. |
| 5    | In the Add Table Name field, Type the name of the new table, and then Click <OK>.  
      Result: The new table name is added to the Table Name box. |
| 6    | With the new table name selected, fill in the Min Volts, Max Volts, DAC Multiplier, Table Axis, and Table Notes fields. |
| 7    | Add the table data by either Typing it in directly or by Cutting and Pasting from another application. |
| 8    | When the table setup is complete, Save the configuration before closing the Table panel.  
      Note: To immediately apply the setup to the front panel, from the File menu Select the Apply Configuration option. |

Continued on next page
Creating an Interpolation Table, Continued

Tables Panel

This graphic illustrates the Tables panel in the Component Configuration window.

Table Name Dialog Box

This graphic illustrates the Table Name dialog box.
# Importing an Interpolation Table

## Introduction

Interpolation tables can be imported from other calibrations.

## Importing an Interpolation Table

This table outlines the steps for importing an interpolation table.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>From the <strong>Operations</strong> menu, <strong>Select</strong> the <strong>Configuration Panel</strong> option.  &lt;br&gt; <strong>Result:</strong> The <strong>Component Configuration</strong> window displays.</td>
</tr>
<tr>
<td>2</td>
<td>On the Menu Bar, <strong>Click</strong> the <strong>Tables</strong> icon [ ].  &lt;br&gt; <strong>Result:</strong> The <strong>Table</strong> panel displays in the <strong>Component Configuration</strong> window.</td>
</tr>
<tr>
<td>3</td>
<td>If any tables have already been added to the configuration, they display in the <strong>Table Name</strong> box. The selected table’s contents display in the table on the left hand side of the panel, and its general setup information displays in the fields below the <strong>Table Name</strong> box.</td>
</tr>
<tr>
<td>4</td>
<td>To import a table, <strong>Click</strong> the <code>&lt;Import&gt;</code> button.  &lt;br&gt; <strong>Result:</strong> The <strong>Open</strong> dialog box displays.</td>
</tr>
<tr>
<td>5</td>
<td>Find the configuration file to import from, and <strong>Click</strong> <code>&lt;Open&gt;</code> .  &lt;br&gt; <strong>Result:</strong> The <strong>Import Tables</strong> dialog box displays.</td>
</tr>
<tr>
<td>6</td>
<td>On the <strong>Import Tables</strong> dialog box, <strong>Select</strong> the tables to import. Once all the desired tables are selected, <strong>Click</strong> <code>&lt;Import Selected&gt;</code> .  &lt;br&gt; <strong>Result:</strong> The table(s) is imported and added to the list of tables.</td>
</tr>
<tr>
<td>7</td>
<td>To edit the table, <strong>Click</strong> on its title to display the value on the left hand side of the panel. Make changes to the table.</td>
</tr>
<tr>
<td>8</td>
<td>When the table setup is complete, <strong>Save</strong> the configuration before closing the <strong>Table</strong> panel.  &lt;br&gt; <strong>Note:</strong> To immediately apply the setup to the front panel, from the <strong>File</strong> menu <strong>Select</strong> the <strong>Apply Configuration</strong> option.</td>
</tr>
</tbody>
</table>

*Continued on next page*
Importing an Interpolation Table, Continued

Tables Panel

This graphic illustrates the Tables panel in the Component Configuration window.

<table>
<thead>
<tr>
<th>TABLE: DEFAULT</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Counts</td>
<td>Eng.Units</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>72</td>
<td>3.125</td>
</tr>
<tr>
<td>3</td>
<td>64</td>
<td>2.25</td>
</tr>
<tr>
<td>4</td>
<td>46</td>
<td>0.875</td>
</tr>
<tr>
<td>5</td>
<td>128</td>
<td>12.5</td>
</tr>
<tr>
<td>6</td>
<td>160</td>
<td>15.4375</td>
</tr>
<tr>
<td>7</td>
<td>192</td>
<td>18.75</td>
</tr>
<tr>
<td>8</td>
<td>224</td>
<td>21.625</td>
</tr>
<tr>
<td>9</td>
<td>256</td>
<td>25</td>
</tr>
<tr>
<td>10</td>
<td>288</td>
<td>28.125</td>
</tr>
<tr>
<td>11</td>
<td>320</td>
<td>31.25</td>
</tr>
<tr>
<td>12</td>
<td>352</td>
<td>34.375</td>
</tr>
<tr>
<td>13</td>
<td>384</td>
<td>37.5</td>
</tr>
<tr>
<td>14</td>
<td>416</td>
<td>40.625</td>
</tr>
<tr>
<td>15</td>
<td>448</td>
<td>43.75</td>
</tr>
<tr>
<td>16</td>
<td>480</td>
<td>46.875</td>
</tr>
<tr>
<td>17</td>
<td>512</td>
<td>50</td>
</tr>
<tr>
<td>18</td>
<td>544</td>
<td>53.125</td>
</tr>
<tr>
<td>19</td>
<td>576</td>
<td>56.25</td>
</tr>
<tr>
<td>20</td>
<td>608</td>
<td>65.575</td>
</tr>
<tr>
<td>21</td>
<td>640</td>
<td>62.5</td>
</tr>
<tr>
<td>22</td>
<td>672</td>
<td>65.625</td>
</tr>
<tr>
<td>23</td>
<td>704</td>
<td>68.75</td>
</tr>
<tr>
<td>24</td>
<td>736</td>
<td>71.875</td>
</tr>
<tr>
<td>25</td>
<td>768</td>
<td>75</td>
</tr>
<tr>
<td>26</td>
<td>800</td>
<td>78.125</td>
</tr>
<tr>
<td>27</td>
<td>832</td>
<td>81.25</td>
</tr>
<tr>
<td>28</td>
<td>864</td>
<td>84.375</td>
</tr>
<tr>
<td>29</td>
<td>896</td>
<td>87.5</td>
</tr>
<tr>
<td>30</td>
<td>928</td>
<td>90.625</td>
</tr>
</tbody>
</table>

Import Tables Dialog Box

This graphic illustrates the Import Tables dialog box.
# Deleting an Interpolation Table

This table outlines the steps for deleting an interpolation table.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | From the **Operations** menu, **Select** the **Configuration Panel** option.  
**Result:** The **Component Configuration** window displays. |
| 2    | Before a table can be deleted, any references to it by components must be removed. To remove these references, go to the component configuration panels and change the **Table** field to another table name or select **None** from the dropdown menu. |
| 3    | When all references to the table to be deleted have been removed, on the Menu Bar, **Click** the **Tables** icon.  
**Result:** The **Table** panel displays in the **Component Configuration** window. |
| 4    | If any tables have already been added to the configuration, they display in the **Table Name** box. The selected table’s contents display in the table on the left hand side of the panel, and its general setup information displays in the fields below the **Table Name** box. |
| 5    | On the **Table** panel **Select** the table to delete. Then **Click** the **<Delete>** button.  
**Result:** The table is deleted and is removed from the table list. |
| 6    | When the changes are complete, **Save** the configuration before closing the **Table** panel.  
**Note:** To immediately apply the setup to the front panel, from the **File** menu **Select** the **Apply Configuration** option. |

*Continued on next page*
Deleting an Interpolation Table, Continued

Tables Panel
This graphic illustrates the Tables panel in the Component Configuration window.

Table Reference
This graphic illustrates the table references that must be removed before deleting an interpolation table.
Section 3 – Configuring Waveform Gauges

Configuring Waveform Gauges

Introduction

The configuration for the waveform gauges, called gauges on the Component Configuration window, is different from all the other components as they require configuration of the waveform.

Configuring Waveform Gauges

This table outlines the steps for configuring waveform gauges.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>From the Operations menu, Select the Configuration Panel option. Result: The Component Configuration window displays.</td>
</tr>
<tr>
<td>2</td>
<td>On the Menu Bar, Click the Gauges icon 📈. Result: The Gauge panel displays in the Component Configuration window.</td>
</tr>
<tr>
<td>3</td>
<td>In the top portion of the Gauges panel, complete the fields for each waveform gauge being used.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Type in the component name.</td>
</tr>
<tr>
<td>Loadbox #</td>
<td>For waveform gauges, Select Wavemaker.</td>
</tr>
<tr>
<td>Channel</td>
<td>Select the channel number from the drop down. This is the physical channel in the Wavemaker. Ensure the channel has the correct card to support the signal.</td>
</tr>
<tr>
<td>Visible</td>
<td>If selected, the control will display on the main window. If not selected, the control will be hidden on the main window.</td>
</tr>
<tr>
<td>Function</td>
<td>Select Freq for waveform gauges or DAC to control a voltage signal instead.</td>
</tr>
<tr>
<td>Default</td>
<td>Sets the default value for the control when the configuration is loaded or the control is reset</td>
</tr>
</tbody>
</table>

Continued on next page
Configuring Waveform Gauges, Continued

Gauge Panel

This graphic illustrates the Gauges panel of the Component Configuration window.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Loadbox #</th>
<th>Channel</th>
<th>Name</th>
<th>Value</th>
<th>Portion</th>
<th>Default</th>
<th>Units</th>
<th>Min</th>
<th>Max</th>
<th>Multiplier</th>
<th>Interlock</th>
<th>Interlock OP</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ENGINE SPEED</td>
<td>WaveMaker</td>
<td>CH1</td>
<td>RPM</td>
<td>0</td>
<td>RPM</td>
<td>0</td>
<td>3000</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>2</td>
<td>TURBO SPEED</td>
<td>WaveMaker</td>
<td>CH13</td>
<td>RPM + 1000</td>
<td>0</td>
<td>150</td>
<td>2000</td>
<td>None</td>
<td>None</td>
<td>None</td>
<td>0</td>
<td>Default</td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>FREQUENT</td>
<td>WaveMaker</td>
<td>CH4</td>
<td>Freq</td>
<td>100</td>
<td>Hz</td>
<td>100</td>
<td>400</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>4</td>
<td>SPARE 1</td>
<td>WaveMaker</td>
<td>CH15</td>
<td>Freq</td>
<td>0</td>
<td>0</td>
<td>150</td>
<td>150</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>5</td>
<td>SPARE 2</td>
<td>WaveMaker</td>
<td>CH2</td>
<td>Freq</td>
<td>0</td>
<td>0</td>
<td>150</td>
<td>150</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>6</td>
<td>Spare</td>
<td>WaveMaker</td>
<td>CH17</td>
<td>Freq</td>
<td>0</td>
<td>0</td>
<td>150</td>
<td>150</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>7</td>
<td>Spare</td>
<td>WaveMaker</td>
<td>CH18</td>
<td>Freq</td>
<td>0</td>
<td>0</td>
<td>150</td>
<td>150</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
</tbody>
</table>

Top Portion of Gauges Panel

This graphic illustrates the fields in the top portion of the Gauges panel.

Continued on next page
This table continues to outline the steps for configuring waveform gauges.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Continued</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Units</td>
<td><strong>Type</strong> in the engineering units for the component.</td>
</tr>
<tr>
<td>Min</td>
<td><strong>Type</strong> the minimum value for the component. This value will display on the gauge, and it must be a whole number.</td>
</tr>
<tr>
<td>Max</td>
<td><strong>Type</strong> the maximum value for the component. This value will display on the gauge, and it must be a whole number.</td>
</tr>
<tr>
<td>Digits</td>
<td>Sets the significant digits on the displays.</td>
</tr>
<tr>
<td>Multiplier</td>
<td><strong>Type</strong> the multiplier to scale the component.</td>
</tr>
<tr>
<td>Interlock</td>
<td>Allows component’s values to be locked together. <strong>Select</strong> the component to which this component should be locked.</td>
</tr>
</tbody>
</table>
| Interlock OP | Allows the user to determine if interlocked components should be **Non-Inverting** or **Inverting**.  
**Note**: This option is only used if the component is a switch. |
| Table | **Sets** the interpolation table for this component.  
**Note**: This option is only used if DAQ is the selected function or a Gauge has a Hz table for its Table Axis and Freq for function. |
Configuring Waveform Gauges, Continued

Gauge Panel
This graphic illustrates the Gauges panel of the Component Configuration window.

Top Portion of Gauges Panel
This graphic illustrates the fields in the top portion of the Gauges panel.

Continued on next page
This table continues to outline the steps for configuring waveform gauges.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>For each waveform gauge setup, the waveform must be setup in the bottom portion of the <strong>Gauges</strong> panel.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name is auto filled in from the top list.</td>
</tr>
<tr>
<td><strong>Waveform Number</strong></td>
<td><strong>Select</strong> the waveform number that corresponds to a stored waveform. See <em>Section 6</em> for current waveform number list. Note: Contact Gartech if unsure about waveform numbers stored in the WaveMaker.</td>
</tr>
<tr>
<td>Card Type</td>
<td><strong>Select</strong> the card type from <em>Arbitrary, Digital</em> and <em>Digital Simulated</em>. These are dependent on what hardware is installed. An arbitrary card can simulate a Digital card by selecting <em>Digital Simulated</em>.</td>
</tr>
<tr>
<td>Sync</td>
<td><strong>Sets</strong> if the waveform is synchronized with other waveforms. Typically used if the signals must clock data out at the same rate.</td>
</tr>
<tr>
<td>Offset</td>
<td><strong>Sets</strong> the offset of the waveform to the master clock in data points. Used to shift Arbitrary waveform data by a specific number of data points. Note: Offsets only apply to arbitrary cards.</td>
</tr>
<tr>
<td>Input</td>
<td><strong>Sets</strong> the Engineering Unit for the data being sent to <em>RPM</em> or <em>Frequency</em>.</td>
</tr>
<tr>
<td>Output</td>
<td>Output drive signal can be Arbitrary, Hall (0 to +5v), or VR (-7v to +7v). This field should autoset to Arb if Arbitrary card is selected.</td>
</tr>
</tbody>
</table>

*Continued on next page*
Configuring Waveform Gauges, Continued

Gauge Panel
This graphic illustrates the Gauges panel of the Component Configuration window.

Bottom Portion of Gauges Panel
This graphic illustrates the fields in the bottom portion of the Gauges panel used for configuring the waveforms.

<table>
<thead>
<tr>
<th>No</th>
<th>Name</th>
<th>Waveform Number</th>
<th>Card Type</th>
<th>Sync</th>
<th>Offset</th>
<th>Input</th>
<th>Output</th>
<th>End Value</th>
<th>Cycle Value</th>
<th>Ramp Rate</th>
<th>End Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>ENGINE SPEED</td>
<td>5</td>
<td>Arb</td>
<td>Sync</td>
<td>0</td>
<td>RPM</td>
<td>Arb</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>TURBO SPEED</td>
<td>1</td>
<td>Arb</td>
<td>No Sync</td>
<td>0</td>
<td>RPM</td>
<td>Ar</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>MASS AIR FLOW</td>
<td>1</td>
<td>Arb</td>
<td>No Sync</td>
<td>0</td>
<td>RPM</td>
<td>Ar</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>SPARE 2</td>
<td>1</td>
<td>Arb</td>
<td>Sync</td>
<td>0</td>
<td>RPM</td>
<td>Ar</td>
<td>2</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>Spalte 1</td>
<td>1</td>
<td>Ab</td>
<td>No Sync</td>
<td>0</td>
<td>RPM</td>
<td>Ar</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>6</td>
<td>Spalte 1</td>
<td>1</td>
<td>Ab</td>
<td>No Sync</td>
<td>0</td>
<td>RPM</td>
<td>Ar</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>7</td>
<td>Spalte 1</td>
<td>1</td>
<td>Ab</td>
<td>No Sync</td>
<td>0</td>
<td>RPM</td>
<td>Ar</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

Continued on next page
This table continues to outline the steps for configuring waveform gauges.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Continued</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Teeth/Rev</td>
<td>Type the teeth per revolution to use for wavemaker calculations.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Applies to digital and digital simulated cards only.</td>
</tr>
<tr>
<td>Cycles/Rev</td>
<td>Type the cycles per revolution to use for wavemaker calculations. This is how many cycles are</td>
</tr>
<tr>
<td></td>
<td>represented in the data that gets loaded into the Arbitrary cards. To obtain a 0.1 degree</td>
</tr>
<tr>
<td></td>
<td>resolution, waveforms are 7200 data points which represent 2 full engine crank cycles/rev.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Applies to Arbitrary cards only.</td>
</tr>
<tr>
<td>Ramp</td>
<td>Type the ramp rate to be used when changing values. This determines how quickly the output</td>
</tr>
<tr>
<td></td>
<td>changes from old value to new value. Set to 0 for immediate change.</td>
</tr>
<tr>
<td>PWM HB Freq</td>
<td>Type the PWM heartbeat frequency if PWM output is desired. The digital card will output a</td>
</tr>
<tr>
<td></td>
<td>constant frequency set by the PWM HB Freq and go from 0-100% duty cycle.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Applies to digital cards only.</td>
</tr>
</tbody>
</table>

5 When the changes are complete, Save the configuration.  
**Note**: To immediately apply the setup to the front panel, from the **File** menu **Select** the **Apply Configuration** option.

Continued on next page
Configuring Waveform Gauges, Continued

**Gauge Panel**

This graphic illustrates the Gauges panel of the Component Configuration window.

![Gauges Panel Graphic](image)

**Bottom Portion of Gauges Panel**

This graphic illustrates the fields in the bottom portion of the Gauges panel used for configuring the waveforms.

<table>
<thead>
<tr>
<th>No</th>
<th>Name</th>
<th>Waveform Number</th>
<th>Card Type</th>
<th>Sync</th>
<th>Offset</th>
<th>Input</th>
<th>Output</th>
<th>ToothWave</th>
<th>Circles/R</th>
<th>Ramps Rate</th>
<th>RPM/PSI Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Engine Speed</td>
<td>5</td>
<td>Arby</td>
<td>Sync</td>
<td>0</td>
<td>RPM</td>
<td>Arby</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>2</td>
<td>Turbo Speed</td>
<td>1</td>
<td>Arby</td>
<td>No Sync</td>
<td>0</td>
<td>RPM</td>
<td>Arby</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>3</td>
<td>Camshaft</td>
<td>1</td>
<td>Arby</td>
<td>No Sync</td>
<td>0</td>
<td>RPM</td>
<td>Arby</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>4</td>
<td>Mass Air Flow</td>
<td>1</td>
<td>Dig</td>
<td>No Sync</td>
<td>0</td>
<td>Freq</td>
<td>Arby</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>5</td>
<td>Spare 2</td>
<td>1</td>
<td>Arby</td>
<td>Sync</td>
<td>0</td>
<td>RPM</td>
<td>Arby</td>
<td>0</td>
<td>2</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>6</td>
<td>Spare</td>
<td>1</td>
<td>Dig</td>
<td>No Sync</td>
<td>0</td>
<td>RPM</td>
<td>Hal</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>7</td>
<td>Spare</td>
<td>1</td>
<td>Dig</td>
<td>No Sync</td>
<td>0</td>
<td>RPM</td>
<td>Hal</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>8</td>
<td>Spare</td>
<td>1</td>
<td>Dig</td>
<td>No Sync</td>
<td>0</td>
<td>RPM</td>
<td>Hal</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>
## Section 4 – Configuring All Other Controls

### Configuring All Other Controls

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>From the <strong>Operations</strong> menu, <strong>Select</strong> the <strong>Configuration Panel</strong> option. Result: The <strong>Component Configuration</strong> window displays.</td>
</tr>
</tbody>
</table>
| 2    | On the Menu Bar, **Click** the icon for the control to setup.  
   Switches  
POT Knob (Ratiometrics)  
Sliders (Resistives)  
Rotary  
Result: The panel for the control type displays in the **Component Configuration** window. |
| 3    | In the top portion of the component panel, complete the fields for each control being used. |

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td><strong>Type</strong> in the component name.</td>
</tr>
<tr>
<td>Loadbox #</td>
<td><strong>Select</strong> the loadbox module for the control.</td>
</tr>
<tr>
<td>Channel</td>
<td><strong>Select</strong> the IO Channel for the control.</td>
</tr>
<tr>
<td>Visible</td>
<td><strong>Sets</strong> if the control is visible or not on the main window.</td>
</tr>
</tbody>
</table>

*Continued on next page*
### Configuration Panel
This graphic illustrates the panel for configuring other controls. This specifically illustrates a portion of the **Switches** panel.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>LocRef #</th>
<th>Channel</th>
<th>Volume</th>
<th>Function</th>
<th>Default</th>
<th>Unid</th>
<th>PS1</th>
<th>PS2</th>
<th>Limit</th>
<th>Interlock</th>
<th>Interlock OP</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>XYZ001CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>2</td>
<td>XYZ002CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>3</td>
<td>XYZ003CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>4</td>
<td>XYZ004CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>5</td>
<td>XYZ005CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>6</td>
<td>XYZ006CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>7</td>
<td>XYZ007CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>8</td>
<td>XYZ008CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>9</td>
<td>XYZ009CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>10</td>
<td>XYZ010CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>11</td>
<td>XYZ011CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>12</td>
<td>XYZ012CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>13</td>
<td>XYZ013CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>14</td>
<td>XYZ014CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>15</td>
<td>XYZ015CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>16</td>
<td>XYZ016CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>17</td>
<td>XYZ017CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>18</td>
<td>XYZ018CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>19</td>
<td>XYZ019CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>20</td>
<td>XYZ020CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>21</td>
<td>XYZ021CH</td>
<td>Parent</td>
<td>CI2012</td>
<td>0</td>
<td>Toggle SW</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
</tbody>
</table>

Continued on next page
### Configuring All Other Controls, Continued

This table continues to outline the steps for configuring switches, ratiometrics, resistives, and rotary switches.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td><strong>Continued</strong></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Function</td>
<td>Select the function of the control.</td>
</tr>
<tr>
<td>Default</td>
<td>Sets the default value for the control when the configuration is loaded or the control is reset.</td>
</tr>
<tr>
<td>Min</td>
<td>Type the minimum value for the component. This value will display on the gauge, and it must be a whole number.</td>
</tr>
<tr>
<td>Max</td>
<td>Type the maximum value for the component. This value will display on the gauge, and it must be a whole number.</td>
</tr>
<tr>
<td>Digits</td>
<td>Select the significant digits for the component.</td>
</tr>
<tr>
<td>Multiplier</td>
<td>Type the multiplier to scale the component.</td>
</tr>
<tr>
<td>Interlock</td>
<td>Allows component’s values to be locked together. Select the component to which this component should be locked.</td>
</tr>
<tr>
<td>Interlock OP</td>
<td>Allows the user to determine if interlocked components should be <strong>Non-Inverting</strong> or <strong>Inverting</strong>.</td>
</tr>
<tr>
<td>Table</td>
<td>Sets the interpolation table for this component.</td>
</tr>
</tbody>
</table>

4 When the changes are complete, **Save** the configuration.

Note: To immediately apply the setup to the front panel, from the **File** menu Select the **Apply Configuration** option.
Configuring All Other Controls, Continued

Configuration Panel

This graphic illustrates the panel for configuring other controls. This specifically illustrates a portion of the Switches panel.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Locate #</th>
<th>Channel</th>
<th>Zone</th>
<th>Function</th>
<th>Default</th>
<th>Unid</th>
<th>Sys</th>
<th>Pix</th>
<th>Cogn</th>
<th>Pulldown</th>
<th>Interlock</th>
<th>Interlock OP</th>
<th>Table</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>kW546CH1</td>
<td>Parent</td>
<td>EU42</td>
<td>0</td>
<td>Toggle Kw</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>2</td>
<td>kW116I1</td>
<td>Parent</td>
<td>SW42</td>
<td>0</td>
<td>Toggle Kw</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>3</td>
<td>Par_SW60</td>
<td>Parent</td>
<td>SW41</td>
<td>0</td>
<td>Toggle Kw</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>4</td>
<td>Par_SW70</td>
<td>Parent</td>
<td>EU41</td>
<td>0</td>
<td>Toggle Kw</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>5</td>
<td>Par_SW80</td>
<td>Parent</td>
<td>SW31</td>
<td>0</td>
<td>Toggle Kw</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>6</td>
<td>Par_SW90</td>
<td>Parent</td>
<td>SW32</td>
<td>0</td>
<td>Toggle Kw</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>7</td>
<td>Par_SSW65</td>
<td>Parent</td>
<td>SW33</td>
<td>0</td>
<td>Toggle Kw</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>8</td>
<td>Par_SSW75</td>
<td>Parent</td>
<td>SW34</td>
<td>0</td>
<td>Toggle Kw</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>9</td>
<td>Par_SSW85</td>
<td>Parent</td>
<td>SW35</td>
<td>0</td>
<td>Toggle Kw</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>10</td>
<td>Par_SSW95</td>
<td>Parent</td>
<td>SW36</td>
<td>0</td>
<td>Toggle Kw</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>11</td>
<td>Brklall1</td>
<td>Parent</td>
<td>EU40</td>
<td>0</td>
<td>Toggle Kw</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>12</td>
<td>Brklall2</td>
<td>Parent</td>
<td>SW30</td>
<td>0</td>
<td>Toggle Kw</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>13</td>
<td>CatIz1</td>
<td>Parent</td>
<td>EU42</td>
<td>0</td>
<td>Toggle Kw</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>14</td>
<td>Par_SW12</td>
<td>Parent</td>
<td>EU42</td>
<td>0</td>
<td>Toggle Kw</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>15</td>
<td>Par_SW13</td>
<td>Parent</td>
<td>EU41</td>
<td>0</td>
<td>Toggle Kw</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>16</td>
<td>Par_SW14</td>
<td>Parent</td>
<td>EU40</td>
<td>0</td>
<td>Toggle Kw</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>17</td>
<td>Par_SW15</td>
<td>Parent</td>
<td>EU39</td>
<td>0</td>
<td>Toggle Kw</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>18</td>
<td>Par_SW16</td>
<td>Parent</td>
<td>EU38</td>
<td>0</td>
<td>Toggle Kw</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>19</td>
<td>Par_SW17</td>
<td>Parent</td>
<td>EU37</td>
<td>0</td>
<td>Toggle Kw</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>20</td>
<td>Par_SW18</td>
<td>Parent</td>
<td>EU36</td>
<td>0</td>
<td>Toggle Kw</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
<tr>
<td>21</td>
<td>Par_SW19</td>
<td>Parent</td>
<td>SW30</td>
<td>0</td>
<td>Toggle Kw</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>None</td>
<td>None</td>
<td>Default</td>
</tr>
</tbody>
</table>
## Section 5 – Configuration Options

### Configuration Options

**Introduction**

The Configuration Options allows the user to name the tabs on the main window as well as hide tabs that are not being used.

**Configuration Options**

This table outlines the steps for setting the configuration options.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | From the **Operations** menu, **Select** the **Configuration Panel** option.  
**Result**: The **Component Configuration** window displays. |
| 2    | On the Menu Bar, **Click** the **Configuration Options** icon ![Configuration Options Icon].  
**Result**: The **Configuration Options** panel displays in the **Component Configuration** window. |
| 3    | In the **Visibility** field, **Deselect** any tab that should be hidden on the main window. |
| 4    | In the **Tab Name** field, **Click** on a tab name to change and **Type** the new name. |
| 5    | When the changes are complete, **Save** the configuration.  
**Note**: To immediately apply the setup to the front panel, from the **File** menu **Select** the **Apply Configuration** option. |

*Continued on next page*
Configuration Options, Continued

Configuration Options Panel

This graphic illustrates the **Configuration Options** panel on the **Component Configuration** window.

![Configuration Options Panel Diagram](image-url)
Chapter 4 – The FMET Interface

Overview

Introduction

The Failure Mode Effects Test, FMET, is a set of actions performed during a Failure Mode Effects Analysis, FMEA. An FMEA requires the user to create specific failure situations and determine the results of those failures on multiple I/O. The GarTech FMET Box provides the ability to perform a Failure Mode Effects Test preliminarily on a bench with a LUIS as well as mounted in a system for real-world testing. It allows the user to interrupt and short ECM lines to specific fault conditions like VBATT and Ground. The GarTech FMET Interface provides a graphical user interface for communicating with the FMET box.

Physical Description

The FMET box is approximately 9”x12”x3.5”. The box can be mounted in the engine compartment to reduce wire lengths. In normal off conditions, the FMET box simply passes all of the harness signals through.

In This Chapter

This table outlines the topics covered in this chapter.

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>How To Connect an FMET Box</td>
<td>78</td>
</tr>
<tr>
<td>FMET Workflow</td>
<td>79</td>
</tr>
<tr>
<td>The FMET Graphical Interface</td>
<td>70</td>
</tr>
</tbody>
</table>
## Section 1 – How To Connect an FMET Box

### How To Connect an FMET Box

<table>
<thead>
<tr>
<th><strong>Introduction</strong></th>
<th>The FMET box has a CAN interface, and only a datalink wire is required to connect the PC to the box.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Connecting the FMET Box</strong></td>
<td>The FMET box is connected between the ECM and the Harness. To connect the FMET box, disconnect the wiring harness from the ECM and connect it into the FMET box cable and then back into the ECM.</td>
</tr>
</tbody>
</table>
Section 2 – FMET Workflow

FMET Workflow

This diagram illustrates the workflow for completing tests using the FMET Interface. This workflow assumes that all hardware is already connected.

1. Set Up or Load Component Configuration File (I/O Controls)
2. Flip the Relay Switches to Apply the Fault To (I/O Controls)
3. Check the COM Status and CURRENT Status (STATUS)
4. Did Exclusion Warning Display?
   - Yes: Change Relays or Modify Exclusions (Component Configuration)
   - No: Flip the Apply Fault Switch to Indicate Where to Apply the Fault (APPLY FAULT)
5. Check the COM Status and CURRENT Status (STATUS)
6. Errors?
   - Yes: Check Hardware as Required
   - No: Change Relays or Modify Exclusions (Component Configuration)
7. Flip the Fault Switch to Apply (FAULTS)
8. Did Exclusion Warning Display?
   - Yes: Watch for Errors as Test Completes
   - No: Watch for Errors as Test Completes
   - Yes: Change Relays or Modify Exclusions (Component Configuration)
Section 3 – The FMET Graphical Interface

Overview

Introduction
The FMET Interface provides a graphical interface for communicating with the FMET box. The FMET Interface is a part of the LUIS Graphical User Interface.

How To Access the FMET Graphical Interface
To access the FMET Interface, from the LUIS Graphical Interface, Open the Hardware menu. From the Hardware menu, Select the FMET Unit option. The FMET Interface displays.

The FMET Interface
The FMET Interface is made up of six basic sections: Menu Bar, Toolbar, Faults Switches, Apply Fault Switches, Status Indicators and I/O Controls.

Continued on next page
Overview, Continued

In This Section

This table outlines the topics covered in this section.

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Menu Bar</td>
<td>82</td>
</tr>
<tr>
<td>Toolbar</td>
<td>83</td>
</tr>
<tr>
<td>Faults Switches</td>
<td>84</td>
</tr>
<tr>
<td>Apply Fault Switches</td>
<td>85</td>
</tr>
<tr>
<td>Status Indicators</td>
<td>86</td>
</tr>
<tr>
<td>I/O Controls</td>
<td>88</td>
</tr>
</tbody>
</table>
# Menu Bar

This table outlines the menus that are available as well as the options available on each menu.

<table>
<thead>
<tr>
<th>Menu</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Open Configuration</strong></td>
<td>Opens the <em>Open</em> dialog box where a saved configuration can be selected and applied to the GUI</td>
</tr>
<tr>
<td></td>
<td><strong>Save Configuration As…</strong></td>
<td>Opens the <em>Save As</em> dialog box where the current GUI configuration can be saved for later use</td>
</tr>
<tr>
<td></td>
<td><strong>Exit</strong></td>
<td>Exits the FMET GUI</td>
</tr>
<tr>
<td><strong>Operation</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Reset -&gt; Relays</strong></td>
<td>Resets all relays</td>
</tr>
<tr>
<td></td>
<td><strong>Configuration Panel</strong></td>
<td>Opens the <em>Component Configuration</em> window to set up the GUI</td>
</tr>
<tr>
<td></td>
<td><strong>Set Max Current</strong></td>
<td>Opens the <em>Relay Current</em> dialog box where the maximum input current can be set in Amps to work as a fuse&lt;br&gt;Note: If the Max Current is exceeded, all relays are shut off.</td>
</tr>
</tbody>
</table>
### Toolbar

This graphic and table outlines the options available from the FMET Interface toolbar.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Open Configuration</td>
</tr>
<tr>
<td><img src="image" alt="Folder" /></td>
<td>Save Configuration</td>
</tr>
<tr>
<td><img src="image" alt="Green Light" /></td>
<td>Reset All Relays</td>
</tr>
<tr>
<td><img src="image" alt="Information" /></td>
<td>Set Max Current</td>
</tr>
<tr>
<td><img src="image" alt="Component" /></td>
<td>Component Configuration</td>
</tr>
<tr>
<td><img src="image" alt="X" /></td>
<td>Reset COM Interface</td>
</tr>
</tbody>
</table>
Fault Switches

Faults Switches
The Faults switches are used to apply a fault to all the selected I/O channels. The generic faults are: Open, VBATT and Ground. There are two additional customizable faults that are labeled FAULT1 and FAULT2 in the FMET Interface.

Switch Positions
The Faults switches can be in the ON or OFF position. The switch is in the ON position when the switch name is displayed in red and the top of the rocker switch is depressed. The switch is in the OFF position when the switch name is displayed in black and the bottom of the rocker switch is depressed.
Apply Fault Switches

The Apply Fault switches are used to set how the fault is to be applied. The appropriate Apply Fault switch should be set before flipping the Faults switch. This following table describes the possibilities.

<table>
<thead>
<tr>
<th>Switch Setting</th>
<th>Apply Fault Through</th>
</tr>
</thead>
<tbody>
<tr>
<td>ECM/HARN</td>
<td>ECM and Harness</td>
</tr>
<tr>
<td>ECM</td>
<td>ECM Only</td>
</tr>
<tr>
<td>HARNESS</td>
<td>Harness Only</td>
</tr>
</tbody>
</table>

The switches indicate which Apply Fault option is selected by displaying its name in red and showing the switch depressed in that direction. Clicking the Harness switch toggles between Harness being selected or ECM being selected, as the lower position of the Harness switch defaults back to ECM.
Status Indicators

The status indicators section provides information on the COM Status, the current draw, in amps, through the relays on each board, as well as the status of each board.

**COM Status**

The COM Status indicator tells the user the current state of the hardware. This table describes the common messages.

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
<th>Basic Troubleshooting</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Hardware has been found and is ready</td>
<td></td>
</tr>
<tr>
<td>ILLHW</td>
<td>Hardware cannot be found</td>
<td>Check hardware connections</td>
</tr>
<tr>
<td>HWINUSE</td>
<td>Hardware is in use by another device</td>
<td>Wait until status changes to OK</td>
</tr>
<tr>
<td>BUSLIGHT</td>
<td>CAN Error</td>
<td>Reset COM Interface</td>
</tr>
<tr>
<td>BUSHEAVY</td>
<td>CAN Error</td>
<td>Reset COM Interface</td>
</tr>
<tr>
<td>BUSOFF</td>
<td>Can device is off</td>
<td>Check CAN device and then reset COM Interface</td>
</tr>
</tbody>
</table>

*Continued on next page*
The Current (Amps) section of the Status Indicators shows the status of each of the possible six boards. When a board is on-line its status light will be green, otherwise it will be black. When a board is on-line, if the cursor is held over the status light, the revision of the code that is in the micro displays.

For each board that is on-line, the draw of all its possible 30 relays is measured and the highest draw is displayed in Amps. If the cursor is held over the Amps display, the name of the relay with the highest draw on that board will be displayed.
I/O Controls

Introduction

The I/O Control switches are divided up into tabs for each of the six possible boards. The Component Configuration window is used to set up the boards, the switches available as well as switch and fault exclusions.

The Component Configuration Window

The Component Configuration window for the FMET Interface is very similar, but not identical, to the Component Configuration window in the LUIS Interface. The File menu is the same, but the Component menu only offers two choices, Relay and Exclusion List. The Tools menu does not provide a Table option, since tables are not used for FMET.

Configuring the I/O Controls

This table outlines the steps for configuring the I/O Controls.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>From the Operation menu, Select the Configuration Panel option. Result: The Component Configuration window displays</td>
</tr>
<tr>
<td>2</td>
<td>To add or remove tabs for boards, from the Tools menu, Select the Configuration Options option. Result: The Configuration Options panel displays</td>
</tr>
<tr>
<td>3</td>
<td>To add a tab, in the Tab Name field, Type the name of the tab, and Click the Visibility field to display a green checkmark.</td>
</tr>
<tr>
<td>4</td>
<td>To remove a tab, Click the Visibility tab to clear the green checkmark.</td>
</tr>
<tr>
<td>5</td>
<td>Once the tab names have been entered and the visibility has been set, save the configuration by Clicking the Save As icon on the toolbar or Selecting the Save Configuration As option from the File menu.</td>
</tr>
</tbody>
</table>
I/O Controls, Continued

Component Configuration Window

This is an example of the Component Configuration window.

Configuration Options Panel

This is an example of the Configuration Options panel.

Continued on next page
I/O Controls, Continued

Configuring the I/O Controls, Continued

This table continues to outline the steps for configuring the I/O Controls.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 6    | Once the configuration is complete and has been saved, Click the Apply icon on the toolbar or Select the Apply option from the Tools menu.  
**Result:** The Apply Configuration dialog box displays to confirm that the configuration should be applied. Click the <Yes> button to continue. The changes are immediately implemented. |

Configuring Switches

7 To configure the switches found on each tab, from the Component menu, **Select** the Relays option or **Click** the Relays icon on the toolbar.  
**Result:** The relay configuration panel displays with all possible switches listed.

8 For each switch being used, modify the fields as necessary.  
**Note:** Multiple switches can be set up for the same I/O pin. The same I/O pin can appear more than once on a single tab, or it can appear on multiple tabs.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Name        | **Type** a name for the switch.  
**Note:** This is the name that will display on the FMET interface. It is not required. |
| Relay Board # | **Select** the appropriate relay board from the dropdown list. |
| Relay #     | **Select** the correct relay # from the dropdown list. |

Continued on next page
I/O Controls, Continued

Relay Configuration Panel

This is an example of the relay configuration panel.

![Component Configuration Panel](image-url)

Continued on next page
## I/O Controls, Continued

This table continues to outline the steps for configuring the I/O Controls.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>8</strong></td>
<td><strong>Continued</strong></td>
</tr>
<tr>
<td><strong>Field</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>Visible</td>
<td>If the relay should be visible, ensure that a green checkmark displays, otherwise make sure that the field is blank.</td>
</tr>
</tbody>
</table>
| ToolTip | **Type** a brief description to display if the mouse is hovered over the switch.  
**Note:** The ToolTip is most commonly used to display Connector Numbers with Pin Number on the ECM. |
| **9** | To rearrange switches, use the Move Up and Move Down icons on the toolbar, or the Move Up and Move Down options from the Tools menu. |
| **10** | Once the switches are all set as needed, save the configuration by Selecting the Save Configuration As option from the File menu or Clicking the Save As icon in the toolbar.  
**Note:** The Print icon on the toolbar, or the Print option on the File menu can be used to easily review the configuration and box connections. |
| **11** | Once the configuration is complete and has been saved, Click the Apply icon on the toolbar or Select the Apply option from the Tools menu.  
**Result:** The Apply Configuration dialog box displays to confirm that the configuration should be applied. Click the <Yes> button to continue. The changes are immediately implemented. |

*Continued on next page*
This is an example of the relay configuration panel.

<table>
<thead>
<tr>
<th>No.</th>
<th>Name</th>
<th>Relay Board #</th>
<th>Relay #</th>
<th>Visible</th>
<th>Tool Tip</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>IGN R/5</td>
<td>RELAY BOARD #1</td>
<td>1</td>
<td>✔️</td>
<td>GREY 71</td>
</tr>
<tr>
<td>2</td>
<td>NA1</td>
<td>RELAY BOARD #1</td>
<td>2</td>
<td>✔️</td>
<td>GREY 21</td>
</tr>
<tr>
<td>3</td>
<td>H2O IN FUEL</td>
<td>RELAY BOARD #1</td>
<td>3</td>
<td>✔️</td>
<td>BLUE 75</td>
</tr>
<tr>
<td>4</td>
<td>COMP INLET TEMP</td>
<td>RELAY BOARD #1</td>
<td>4</td>
<td>✔️</td>
<td>BLUE 58</td>
</tr>
<tr>
<td>5</td>
<td>COOLANT TEMP</td>
<td>RELAY BOARD #1</td>
<td>5</td>
<td>✔️</td>
<td>BLUE 40</td>
</tr>
<tr>
<td>6</td>
<td>CC PRES SENS</td>
<td>RELAY BOARD #1</td>
<td>6</td>
<td>✔️</td>
<td>BLUE 23</td>
</tr>
<tr>
<td>7</td>
<td>SPARE AA03</td>
<td>RELAY BOARD #1</td>
<td>7</td>
<td>✔️</td>
<td>BLUE 57</td>
</tr>
<tr>
<td>8</td>
<td>DMI (THMAP)</td>
<td>RELAY BOARD #1</td>
<td>8</td>
<td>✔️</td>
<td>BLUE 39</td>
</tr>
<tr>
<td>9</td>
<td>EGR ORIFC TEMP</td>
<td>RELAY BOARD #1</td>
<td>9</td>
<td>✔️</td>
<td>BLUE 22</td>
</tr>
<tr>
<td>10</td>
<td>SPD CTRL SW 1</td>
<td>RELAY BOARD #1</td>
<td>10</td>
<td>✔️</td>
<td>GREY 76</td>
</tr>
<tr>
<td>11</td>
<td>DOC INLET T0</td>
<td>RELAY BOARD #1</td>
<td>11</td>
<td>✔️</td>
<td>GREY 40</td>
</tr>
<tr>
<td>12</td>
<td>DPF INLET T1</td>
<td>RELAY BOARD #1</td>
<td>12</td>
<td>✔️</td>
<td>GREY 23</td>
</tr>
<tr>
<td>13</td>
<td>DPF OUTLET T2</td>
<td>RELAY BOARD #1</td>
<td>13</td>
<td>✔️</td>
<td>GREY 76</td>
</tr>
<tr>
<td>14</td>
<td>SPARE AA01</td>
<td>RELAY BOARD #1</td>
<td>14</td>
<td>✔️</td>
<td>GREY 57</td>
</tr>
<tr>
<td>15</td>
<td>FUEL RAIL PRES</td>
<td>RELAY BOARD #1</td>
<td>15</td>
<td>✔️</td>
<td>BLUE 74</td>
</tr>
<tr>
<td>16</td>
<td>COMP IN PRES</td>
<td>RELAY BOARD #1</td>
<td>16</td>
<td>✔️</td>
<td>BLUE 56</td>
</tr>
<tr>
<td>17</td>
<td>INTAK MAN PRES</td>
<td>RELAY BOARD #1</td>
<td>17</td>
<td>✔️</td>
<td>BLUE 38</td>
</tr>
<tr>
<td>18</td>
<td>ALT V SENS</td>
<td>RELAY BOARD #1</td>
<td>18</td>
<td>✔️</td>
<td>BLUE 21</td>
</tr>
<tr>
<td>19</td>
<td>SPARE M0N</td>
<td>RELAY BOARD #1</td>
<td>19</td>
<td>✔️</td>
<td>BLUE 73</td>
</tr>
<tr>
<td>20</td>
<td>SPD CTRL SW 2</td>
<td>RELAY BOARD #1</td>
<td>20</td>
<td>✔️</td>
<td>BLUE 39</td>
</tr>
<tr>
<td>21</td>
<td>REM THRNL SIG</td>
<td>RELAY BOARD #1</td>
<td>21</td>
<td>✔️</td>
<td>GREY 22</td>
</tr>
<tr>
<td>22</td>
<td>SPARE AA02</td>
<td>RELAY BOARD #1</td>
<td>22</td>
<td>✔️</td>
<td>BLUE 74</td>
</tr>
<tr>
<td>23</td>
<td>SCOT DELTA PKG</td>
<td>RELAY BOARD #1</td>
<td>23</td>
<td>✔️</td>
<td>BLUE 56</td>
</tr>
<tr>
<td>24</td>
<td>PEDAL POS 1</td>
<td>RELAY BOARD #1</td>
<td>24</td>
<td>✔️</td>
<td>GREY 37</td>
</tr>
</tbody>
</table>
## Configuring the I/O Controls, Continued

This table continues to outline the steps for configuring the I/O Controls.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Setting Exclusions</strong></td>
<td></td>
</tr>
</tbody>
</table>
| 12 | Exclusions can be set to prevent relays from tripping under certain conditions. To set exclusions, **Click** the Exclusions icon on the toolbar or **Select** the *Exclusion List* option from the *Component* menu.  
   **Result:** The *Exclusion List* panel displays. |
| 13 | To set an exclusion, in the first *Name* field, **Select** the appropriate relay or fault from the dropdown list. In the second *Name* field, **Select** the appropriate relay or fault from the dropdown list.  
   **Note:** Exclusions are mutually exclusive. It doesn’t matter which relay or fault is listed first or second. As long as one relay is switched ON the other cannot be switched ON.  
   **Result:** The *Relay No.* fields are automatically populated. |
| 14 | The **Delete** button can be used to remove exclusions. |
| 17 | Once all the exclusions have been set, save the configuration by **Selecting** the *Save Configuration As* option from the *File* menu or **Clicking** the Save As icon in the toolbar. |
| 18 | Once the exclusions have been set and saved, **Click** the Apply icon on the toolbar or **Select** the *Apply* option from the *Tools* menu.  
   **Result:** The *Apply Configuration* dialog box displays to confirm that the configuration should be applied. **Click** the *Yes* button to continue. The changes are immediately implemented. |
| 19 | Once the boards, relays and exclusions have been set, saved and applied, close the *Component Configuration* window.  
   **Note:** If the FMET Interface does not reflect the changes made, the changes must not have been applied. Re-open the *Component Configuration* window, load the saved configuration files and **Apply** the changes. |

*Continued on next page*
This is an example of the *Exclusion List* panel.

<table>
<thead>
<tr>
<th>Relay No.</th>
<th>Name</th>
<th>Relay No.</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>27</td>
<td>Fault: VBATT</td>
<td>28</td>
<td>Fault: GND</td>
</tr>
<tr>
<td>27</td>
<td>Fault: VBATT</td>
<td>29</td>
<td>SCR OUTLET T3</td>
</tr>
<tr>
<td>27</td>
<td>Fault: VBATT</td>
<td>30</td>
<td>VSS EN S RTN2</td>
</tr>
<tr>
<td>27</td>
<td>Fault: VBATT</td>
<td>31</td>
<td>VSS EN S RTN2</td>
</tr>
<tr>
<td>1</td>
<td>IGN R JS</td>
<td>28</td>
<td>Fault: GND</td>
</tr>
<tr>
<td>1</td>
<td>IGN R JS</td>
<td>29</td>
<td>SCR OUTLET T3</td>
</tr>
<tr>
<td>1</td>
<td>IGN R JS</td>
<td>30</td>
<td>VSS EN S RTN2</td>
</tr>
<tr>
<td>1</td>
<td>IGN R JS</td>
<td>31</td>
<td>VSS EN S RTN2</td>
</tr>
<tr>
<td>0</td>
<td>None</td>
<td>0</td>
<td>None</td>
</tr>
</tbody>
</table>
Chapter 5 – Appendix

Overview

Introduction

The following topics discuss some details of LUIS specifications and troubleshooting methods.

In This Section

This table outlines the topics covered in this chapter.

<table>
<thead>
<tr>
<th>Topic</th>
<th>See Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waveforms</td>
<td>98</td>
</tr>
<tr>
<td>RS232 Interface</td>
<td>99</td>
</tr>
<tr>
<td>DAC Specifics</td>
<td>101</td>
</tr>
<tr>
<td>Address Switch</td>
<td>102</td>
</tr>
<tr>
<td>Table Calibration</td>
<td>103</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>105</td>
</tr>
<tr>
<td>Connectors and Pinout</td>
<td>110</td>
</tr>
<tr>
<td>CAN Protocol</td>
<td>119</td>
</tr>
<tr>
<td>Multi-Parent Setup</td>
<td>128</td>
</tr>
</tbody>
</table>
Section 1 – Waveforms

Waveforms

Introduction

The Wavemaker inside of LUIS has built in support for specific waveform data. The user can select specific waveforms from the Configuration Screen and these will be loaded on power cycle. Only one waveform is needed to load both waveforms into the first two channels.

Waveform Data

This table describes the current support for the specific waveforms.

<table>
<thead>
<tr>
<th>Waveform Number</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>60-2 / 6+1 Hall (ISB)</td>
</tr>
<tr>
<td>2</td>
<td>24+1 / 24+1 VR</td>
</tr>
<tr>
<td>3</td>
<td>60-2 / 6+1 Hall (HHP)</td>
</tr>
<tr>
<td>4</td>
<td>24+1 / 24+1 Hall</td>
</tr>
<tr>
<td>5</td>
<td>60-2 / 12+1 Hall (MY07)</td>
</tr>
<tr>
<td>6</td>
<td>60-2 / 24+1 Hall (HHP 45/60)</td>
</tr>
<tr>
<td>7</td>
<td>N/A</td>
</tr>
<tr>
<td>8</td>
<td>N/A</td>
</tr>
<tr>
<td>9</td>
<td>60-2 / 12+1 Hall (MY07)</td>
</tr>
<tr>
<td>10</td>
<td>N/A</td>
</tr>
<tr>
<td>11</td>
<td>60-2 / 8+1 Hall</td>
</tr>
<tr>
<td>12</td>
<td>N/A</td>
</tr>
<tr>
<td>13</td>
<td>60-2 / 4+1 Hall</td>
</tr>
<tr>
<td>14</td>
<td>N/A</td>
</tr>
<tr>
<td>15</td>
<td>N/A</td>
</tr>
</tbody>
</table>
Section 2 – RS232 Interface

RS232 Interface

Introduction

The RS232 port on the rear panel of LUIS supports eight commands. The port setup is 19.2k bits per second, 8 data bits, No Parity, 1 stop bit, and No flow control.

RS232 Commands

This table describes the valid RS232 commands.

<table>
<thead>
<tr>
<th>Description</th>
<th>Symbol</th>
<th>Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rear Axle Ratio Change</td>
<td>A</td>
<td>Rear axle ratio as a floating point number. The decimal point is always</td>
<td>A05.29XXXX sets the new rear axle ratio to 5.29. The vehicle speed signal</td>
</tr>
<tr>
<td></td>
<td></td>
<td>the 3rd character. If less than 10, a leading zero must be included.</td>
<td>will be recalculated with the new RAR value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Data range: 0 - 99.99</td>
<td></td>
</tr>
<tr>
<td>Waveform type change request.</td>
<td>E</td>
<td>Waveform Type as a whole number. If less than 10, a leading zero must</td>
<td>E011500XX sets the new waveform to type &quot;01&quot; and the new engine speed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>be included.</td>
<td>request to 1500rpm</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Default settings</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Waveform will be recalculated</td>
<td></td>
</tr>
<tr>
<td>Fan speed change request</td>
<td>F</td>
<td>Fan Speed as a whole number in RPM. Leading zero(s) must be included</td>
<td>F1234XXXXXX sets the new Fan Speed to 1,234 RPM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>for and speed request smaller than 1000 RPM. Data range 0 - 9999</td>
<td></td>
</tr>
<tr>
<td>Turbo speed change request</td>
<td>G</td>
<td>Turbo speed as a floating point number in KRPM. Leading zero(s) must</td>
<td>G012.4XXXXXX sets the new turbo speed to 12,400 RPM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>be included for any speed request smaller than 100 KRPM. Data range: 0</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 999.9</td>
<td></td>
</tr>
<tr>
<td>VSS teeth per interrupt change</td>
<td>I</td>
<td>Number of teeth per interrupt as a whole number. If less than 10, a</td>
<td>I16XXXXXX sets the new teeth per interrupt values. The vehicle speed</td>
</tr>
<tr>
<td>request</td>
<td></td>
<td>leading zero must be included. Data Range: 0 - 99</td>
<td>signal will be recalculated with the new value.</td>
</tr>
</tbody>
</table>

Continued on next page
## RS232 Interface, Continued

### RS232 Commands, Continued

This table continues to describe the valid RS232 commands.

<table>
<thead>
<tr>
<th>Description</th>
<th>Symbol</th>
<th>Format</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>ESS/EPS change request</td>
<td>R</td>
<td>Engine speed as a whole number in RPM. Leading zeros must be added for any speed request smaller than 1000 RPM. Data range: 0 - 9999</td>
<td>R1234XXXX sets the new ESS/EPS speed to 1,234 RPM.</td>
</tr>
<tr>
<td>Tire size change request</td>
<td>T</td>
<td>Tire size as a whole number in revolutions per mile. If less than 100, leading zero(s) must be included.</td>
<td>T508XXXXXX sets the new tire size to 508 rev/mile. The vehicle speed signal will be recalculated with the new value</td>
</tr>
<tr>
<td>Vehicle speed change request</td>
<td>V</td>
<td>Vehicle speed as a floating point number in MPH. If less than 100, leading zero(s) must be included. Data range: 0 - 999.99</td>
<td>V012.34XX sets the new vehicle speed to 12.34 MPH.</td>
</tr>
</tbody>
</table>

### Channel Assignment

The following table lists the I/O channel assignments that must be followed when sending commands via the RS232 interface.

<table>
<thead>
<tr>
<th>Analog Outputs</th>
<th>Channel Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Box</td>
<td>1-32</td>
</tr>
<tr>
<td>Parent Sidecar</td>
<td>33 - 44</td>
</tr>
<tr>
<td>Child 1 Box</td>
<td>45 - 76</td>
</tr>
<tr>
<td>Child 2 Box</td>
<td>77 - 108</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Switches</th>
<th>Channel Numbers</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Box</td>
<td>1 - 32</td>
</tr>
<tr>
<td>Parent Sidecar</td>
<td>33 - 40</td>
</tr>
<tr>
<td>Child 1 Box</td>
<td>41 - 72</td>
</tr>
<tr>
<td>Child 2 Box</td>
<td>73 - 104</td>
</tr>
</tbody>
</table>
Section 3 – DAC Specifics

DAC Specifics

Introduction

The LUIS hardware has limitations on how accurate it can represent an Analog voltage. These limitations are based on the Digital to Analog Converters (DAC’s) that are used to output the analog voltage.

DAC Limits

This table describes the DAC limitations.

<table>
<thead>
<tr>
<th>Component</th>
<th>DAC Resolution</th>
<th>Reference Voltage Limit</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent Box</td>
<td>12 Bits</td>
<td>5.5v</td>
</tr>
<tr>
<td>Parent Sidecar</td>
<td>Ch 1-8: 12 Bits</td>
<td>Ch 1-8: 5.5v</td>
</tr>
<tr>
<td></td>
<td>Ch 9-12: 8 Bits</td>
<td>Chan 9-12: 32v</td>
</tr>
<tr>
<td>Child 1 Box</td>
<td>12 Bits</td>
<td>5.5v</td>
</tr>
<tr>
<td>Child 2 Box</td>
<td>12 Bits</td>
<td>5.5v</td>
</tr>
</tbody>
</table>
Section 4 – Address Switch

Address Switch

Introduction

The LUIS hardware has a selector switch on the front panel to establish its address on the data link bus. The address determines if the box is recognized as a Parent or Child box.

Switch Settings

This table describes the switch settings:

<table>
<thead>
<tr>
<th>Number</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Parent</td>
</tr>
<tr>
<td>1</td>
<td>Child 1</td>
</tr>
<tr>
<td>2</td>
<td>Child 2</td>
</tr>
<tr>
<td>3-9</td>
<td>Do Not Use</td>
</tr>
</tbody>
</table>
### Section 5 – Table Calibration

**Table Calibration**

**Introduction**
LUIS uses look up tables to correlate engineering units that are on the GUI interface to analog values that it outputs to the unit under test. The user can adjust these values so the engineering units on the GUI match what the unit under test calculates it to be.

**Table Calibration**
This table describes the table calibration procedure.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | From the **Operations** menu, Select the **Configuration Panel** option.  
*Result:* The **Component Configuration** window displays. |
| 2    | On the Menu Bar, Click the **Tables** icon ![Icon].  
*Result:* The **Table** panel displays in the **Component Configuration** window. |
| 3    | Select the table from the list of tables that need to be calibrated. |
| 4    | The table first needs to be very simple so a full range can be achieved. This is done by setting two full range points for the sensor. In the table data on the left pane on line 1 enter 0 counts and 0 for Eng Units. |
| 5    | On line 2 enter 1023 for counts and the maximum engineering unit (i.e. 100 for 100% throttle). Delete all other entries for the table. |
| 6    | Connect a tool that can communicate with the unit under test and display the parameters that need to be calibrated. |
| 7    | Go back to the LUIS Main panel and slowly adjust the knob/slider until the tool that’s communicating to the unit under test reads the lowest reading (i.e. when throttle goes from 0% to 1%). Record the LUIS value. |

*Continued on next page*
**Table Calibration, Continued**

This table continues to describe the table calibration procedure.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Continue slowly increasing the knob/slide on LUIS GUI until the tool that’s communicating to the unit under test reads the maximum value for that sensor (i.e. when throttle is at 100%). Record the value that is on the LUIS GUI.</td>
</tr>
<tr>
<td>9</td>
<td>In the LUIS table for that sensor, change the first count value in row one to (1023 * LUIS first value) and in row two (1023 * LUIS second value). The table now has two valid points and is complete.</td>
</tr>
</tbody>
</table>
Section 6 – Troubleshooting

Troubleshooting COM Status

Introduction

LUIS has a number of cable connections and is a complex electronic test instrument. The items listed in this section describe the most common issues that might arise while using LUIS.

Troubleshooting COM Status

To troubleshoot the COM Status, read the COM Status on the top right of the LUIS GUI and refer to the table on the next page.

Note: After making corrections to the setup, the <Reset COM Interface> button may need to be clicked.

Continued on next page
**Troubleshooting COM Status, Continued**

<table>
<thead>
<tr>
<th>COM Status</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>Check the lamp indicators just below the COM Status on the LUIS GUI. If the load box light is not ON, make sure power for all the load boxes is turned ON. If your load box has a sidecar circuit, verify that the CAN cable connections in the back of the sidecar are plugged into the Parent box and your PC is connected into the sidecar CAN connector. Note: For more information, see Section 2 - How to Setup A LUIS in this document.</td>
</tr>
<tr>
<td>BUSHEAVY, OVERRUN</td>
<td>Usually caused by bad connection from the Peak adapter to LUIS or an improper amount of CAN cable termination resistors. The LUIS hardware requires a minimum of one and maximum of two 120 ohm termination resistors on the CAN bus for proper operation. For more information about how to construct a CAN node see the SAE J1939-11 specification. Also could be the result of other datalink devices on the CAN bus using an inappropriate amount of bandwidth.</td>
</tr>
<tr>
<td>BUSOFF</td>
<td>Check the Peak adapter settings in the NetConfig software that gets installed with LUIS by Clicking &lt;Start&gt; -&gt; All Programs -&gt; PCAN -&gt; NetConfig. After running this program, Select PEAK USB-CAN, (select PCI if your setup uses a PCI-to-CAN adapter), from the list and then select the Net. Edit the Net and verify that the CAN baud rate is set for 250Kbit/sec. Also see BUSHEAVY section.</td>
</tr>
</tbody>
</table>

*Continued on next page*
Troubleshooting COM Status, Continued

This table continues to give troubleshooting suggestions based on the COM Status on the top right of the LUIS GUI.

<table>
<thead>
<tr>
<th>COM Status</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>ILLHW</td>
<td>Open up <strong>Control Panel</strong> in Windows and <strong>DoubleClick</strong> on the <strong>CAN Hardware</strong> icon. Select the <em>USB</em> radio button at the top of the screen and <strong>Click</strong> <em>&lt;OK&gt;</em>. (select PCI if your setup uses a PCI-to-CAN adapter). Restart LUIS. Verify that the Net name that the LUIS software is using is the connected to the hardware. In LUIS <strong>Select Hardware-&gt;Peak Adapter-&gt;Set Net Name</strong>. This name must be the same as the one in NetConfig software. Run the NetConfig software by <strong>Clicking</strong> <em>&lt;Start&gt;</em> - <em>All Programs</em> - <em>PCAN</em> - <em>NetConfig</em>. Then select the Peak adapter being used. The Nets for that device are then listed underneath and one of the Nets should match what LUIS is set for. The default Net name for LUIS is LUIS_Net_1. The bus speed must be set to 250Kbit/sec.</td>
</tr>
<tr>
<td>NOVXD</td>
<td>Verify that the PEAK adapter is plugged into your PC’s USB port or PCI slot. If not, connect the adapter and re-start the LUIS program.</td>
</tr>
<tr>
<td>HWINUSE</td>
<td>Another application is using the Peak hardware and not using the same Net name that LUIS is using. Change the Net name in LUIS by selecting <strong>Hardware-&gt;Peak Adapter-&gt;Set Net Name</strong> to the same name as the other application.</td>
</tr>
</tbody>
</table>
Troubleshooting Closed Loop Engine Speed

These tables outline the steps for troubleshooting Closed Loop Engine Speed.

**Symptom:** Engine does not start, RPM gauge does not move.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1    | Verify that the LOAD BOX STATUS indicator lamps are working correctly.  
      | Note: In most cases this means that Parent, Sidecar and Wavemaker are all Online. |
| 2    | Verify to following:  
      | • ECM wiring harness is fully connected  
      | • VBATT power supply is connected to LUIS and turned on  
      | • VBATT switch on LUIS GUI is turned ON  
      | • Key switch is turned ON  
      | • Verify correct LUIS configuration file is loaded for ECM under test  
      | • Set PERCENT LOAD slider to 0  
      | • Set GAIN ADJUST slider to 300  
      | • Set OPEN/CLOSED loop switch to CLOSED loop. If already in CLOSED position, toggle to OPEN and back to CLOSED loop  
      | • ECM under test supports J1939 broadcast of Percent Load and Engine Speed |

*Continued on next page*
These tables continue to outline the steps for troubleshooting Closed Loop Engine Speed.

**Symptom:** Engine RPM dies without reaching idle RPM

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Verify PERCENT LOAD slider is set to 0.</td>
</tr>
<tr>
<td>2</td>
<td>Increase GAIN ADJUST slider and try again.</td>
</tr>
<tr>
<td>3</td>
<td>Verify the ECM control software is not trying to command a shutdown.</td>
</tr>
</tbody>
</table>

**Symptom:** Engine RPM does not respond to Throttle input.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Verify there are no active ECM faults which cause fueling and/or speed derates.</td>
</tr>
<tr>
<td>2</td>
<td>If ECM calibration required idle validation, turn on the LUIS AUTO IVS switch. Cycle the throttle a few times to eliminate Throttle and IVS faulty codes.</td>
</tr>
</tbody>
</table>

**Symptom:** Engine RPM is unstable

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Adjust GAIN ADJUST slider and PERCENT LOAD sliders until RPM becomes stable.</td>
</tr>
</tbody>
</table>
Section 7 – Connectors and Pinout

Connectors

Introduction

The Parent LUIS box has three 50 pin connectors on top that interface the load box to the unit under test. These interface connectors are all Deutsch 50 pin connectors. The Sidecar also has a 50 pin connector, and an additional 1 or 2 rear panel green connectors. The pinout of the green connectors may be application specific. Please consult your ECM’s LUIS wiring diagram for green connector pinout information.

Connectors

This table describes the connector pinout information.

<table>
<thead>
<tr>
<th>Unit</th>
<th>Connectors</th>
</tr>
</thead>
<tbody>
<tr>
<td>Parent</td>
<td>50-01, 50-02, 50-03</td>
</tr>
<tr>
<td>Sidecar</td>
<td>50-04</td>
</tr>
<tr>
<td>Child 1</td>
<td>50-01, 50-02, 50-03</td>
</tr>
<tr>
<td>Child 2</td>
<td>50-01, 50-02, 50-03</td>
</tr>
</tbody>
</table>
**Connector Pinout – Parent/Child 1/Child 2/ Pin Key 01**

This table gives the connector pinout for Parent/Child 1/Child 2/Pin Key 01.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
<th>I/O</th>
<th>Range</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Lamp 3 low side</td>
<td>IN</td>
<td>0-VBATT</td>
<td>Low side driver input for front panel LED (high side = key switch)</td>
</tr>
<tr>
<td>2</td>
<td>Lamp 4 low side</td>
<td>IN</td>
<td>0-VBATT</td>
<td>Low side driver input for front panel LED (high side = key switch)</td>
</tr>
<tr>
<td>3</td>
<td>Lamp 5 low side</td>
<td>IN</td>
<td>0-VBATT</td>
<td>Low side driver input for front panel LED (high side = key switch)</td>
</tr>
<tr>
<td>4</td>
<td>5.5V OUT</td>
<td>OUT</td>
<td>0-3.3v</td>
<td>LUIS power supply reference output</td>
</tr>
<tr>
<td>5</td>
<td>AD0 IN</td>
<td>IN</td>
<td>0-3.3v</td>
<td>Analog signal input with internal 10k pullup to 3.3v</td>
</tr>
<tr>
<td>6</td>
<td>AD1 IN</td>
<td>IN</td>
<td>0-3.3v</td>
<td>Analog signal input with internal 10k pullup to 3.3v</td>
</tr>
<tr>
<td>7</td>
<td>Ground OUT</td>
<td>OUT</td>
<td>Unswitched Battery Return</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>N/C</td>
<td></td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>N/C</td>
<td></td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td>10</td>
<td>N/C</td>
<td></td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td>11</td>
<td>N/C</td>
<td></td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td>12</td>
<td>Load 8A IN</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to driven side of Load</td>
</tr>
<tr>
<td>13</td>
<td>Load 1+ IN</td>
<td>IN</td>
<td>47 ohm</td>
<td>High side of Load (low side = ground)</td>
</tr>
<tr>
<td>14</td>
<td>Load 2+ IN</td>
<td>IN</td>
<td>47 ohm</td>
<td>High side of Load (low side = ground)</td>
</tr>
<tr>
<td>15</td>
<td>Load 3+ IN</td>
<td>IN</td>
<td>47 ohm</td>
<td>High side of Load (low side = ground)</td>
</tr>
<tr>
<td>16</td>
<td>Load 4+ IN</td>
<td>IN</td>
<td>47 ohm</td>
<td>High side of Load (low side = ground)</td>
</tr>
<tr>
<td>17</td>
<td>Load 5+ IN</td>
<td>IN</td>
<td>47 ohm</td>
<td>High side of Load (low side = ground)</td>
</tr>
<tr>
<td>18</td>
<td>Load 6+ IN</td>
<td>IN</td>
<td>47 ohm</td>
<td>High side of Load (low side = ground)</td>
</tr>
<tr>
<td>19</td>
<td>Load 7A IN</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to driven side of load</td>
</tr>
<tr>
<td>20</td>
<td>Load 7B IN</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to common side of load</td>
</tr>
<tr>
<td>21</td>
<td>N/C</td>
<td></td>
<td>Not used</td>
<td></td>
</tr>
<tr>
<td>22</td>
<td>Load 8B IN</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to common side of load</td>
</tr>
<tr>
<td>23</td>
<td>Load 9A IN</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to driven side of load</td>
</tr>
<tr>
<td>24</td>
<td>Load 9B IN</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to common side of load</td>
</tr>
<tr>
<td>25</td>
<td>Ground OUT</td>
<td>OUT</td>
<td>Unswitched Battery Return</td>
<td></td>
</tr>
</tbody>
</table>

*Continued on next page*
## Connector Pinout – Parent/Child 1/Child 2/ Pin Key 01, Continued

This table continues to give the connector pinout for Parent/Child 1/Child 2/Pin Key 01.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
<th>I/O</th>
<th>Range</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>26</td>
<td>Lamp 1 low side</td>
<td>IN</td>
<td>0-VBATT</td>
<td>Low side driver input for front panel LED (high side = key switch)</td>
</tr>
<tr>
<td>27</td>
<td>Lamp 2 low side</td>
<td>IN</td>
<td>0-VBATT</td>
<td>Low side driver input for front panel LED (high side = key switch)</td>
</tr>
<tr>
<td>28</td>
<td>Load 18B</td>
<td>IN</td>
<td>10k</td>
<td>Connect to common side of load</td>
</tr>
<tr>
<td>29</td>
<td>Load 18A</td>
<td>IN</td>
<td>10k</td>
<td>Connect to driven side of load</td>
</tr>
<tr>
<td>30</td>
<td>Load 17B</td>
<td>IN</td>
<td>10k</td>
<td>Connect to common side of load</td>
</tr>
<tr>
<td>31</td>
<td>Load 17A</td>
<td>IN</td>
<td>10k</td>
<td>Connect to driven side of load</td>
</tr>
<tr>
<td>32</td>
<td>Load 16B</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to common side of load</td>
</tr>
<tr>
<td>33</td>
<td>Load 16A</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to driven side of load</td>
</tr>
<tr>
<td>34</td>
<td>Ground</td>
<td>OUT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>35</td>
<td>Ground</td>
<td>OUT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>36</td>
<td>Ground</td>
<td>OUT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>37</td>
<td>Ground</td>
<td>OUT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>38</td>
<td>Ground</td>
<td>OUT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>39</td>
<td>Load 15B</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to common side of load</td>
</tr>
<tr>
<td>40</td>
<td>Load 15A</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to driven side of load</td>
</tr>
<tr>
<td>41</td>
<td>Load 14B</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to common side of load</td>
</tr>
<tr>
<td>42</td>
<td>Load 14A</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to driven side of load</td>
</tr>
<tr>
<td>43</td>
<td>Load 13B</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to common side of load</td>
</tr>
<tr>
<td>44</td>
<td>Load 13A</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to driven side of load</td>
</tr>
<tr>
<td>45</td>
<td>Load 12B</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to common side of load</td>
</tr>
<tr>
<td>46</td>
<td>Load 12A</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to driven side of load</td>
</tr>
<tr>
<td>47</td>
<td>Load 11B</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to common side of load</td>
</tr>
<tr>
<td>48</td>
<td>Load 11A</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to driven side of load</td>
</tr>
<tr>
<td>49</td>
<td>Load 10B</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to common side of load</td>
</tr>
<tr>
<td>50</td>
<td>Load 10A</td>
<td>IN</td>
<td>47 ohm</td>
<td>Connect to driven side of load</td>
</tr>
</tbody>
</table>
Connector Pinout – Parent/Child 1/Child 2/50 Pin Key 02

This table gives the connector pinout for Parent/Child 1/Child 2/50 Pin Key 02.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
<th>I/O</th>
<th>Range</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel 1</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>2</td>
<td>Channel 2</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>3</td>
<td>Channel 3</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>4</td>
<td>Channel 4</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>5</td>
<td>Channel 5</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>6</td>
<td>Channel 6</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>7</td>
<td>Channel 7</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>8</td>
<td>Channel 8</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>9</td>
<td>Channel 9</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>10</td>
<td>Channel 10</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>11</td>
<td>Channel 11</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>12</td>
<td>Channel 12</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>13</td>
<td>Channel 13</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>14</td>
<td>Channel 14</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>15</td>
<td>Channel 15</td>
<td>OUT</td>
<td>0-VSENS1</td>
<td>Sensor output</td>
</tr>
<tr>
<td>16</td>
<td>Channel 16</td>
<td>OUT</td>
<td>0-VSENS1</td>
<td>Sensor output</td>
</tr>
<tr>
<td>17</td>
<td>Channel 17</td>
<td>OUT</td>
<td>0-VSENS2</td>
<td>Sensor output</td>
</tr>
<tr>
<td>18</td>
<td>Channel 18</td>
<td>OUT</td>
<td>0-VSENS2</td>
<td>Sensor output</td>
</tr>
<tr>
<td>19</td>
<td>Channel 19</td>
<td>OUT</td>
<td>0-VSENS2</td>
<td>Sensor output</td>
</tr>
<tr>
<td>20</td>
<td>Channel 20</td>
<td>OUT</td>
<td>0-VSENS2</td>
<td>Sensor output</td>
</tr>
<tr>
<td>21</td>
<td>Channel 21</td>
<td>OUT</td>
<td>0-VSENS3</td>
<td>Sensor output</td>
</tr>
<tr>
<td>22</td>
<td>Channel 22</td>
<td>OUT</td>
<td>0-VSENS3</td>
<td>Sensor output</td>
</tr>
<tr>
<td>23</td>
<td>Channel 23</td>
<td>OUT</td>
<td>0-VSENS3</td>
<td>Sensor output</td>
</tr>
<tr>
<td>24</td>
<td>Channel 24</td>
<td>OUT</td>
<td>0-VSENS3</td>
<td>Sensor output</td>
</tr>
<tr>
<td>25</td>
<td>Channel 25</td>
<td>OUT</td>
<td>0-VSENS4</td>
<td>Sensor output</td>
</tr>
</tbody>
</table>
Connector Pinout – Parent/Child 1/Child 2/ 50 Pin Key 02, Continued

This table continues to give the connector pinout for Parent/Child 1/Child 2/50 Pin Key 02.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
<th>I/O</th>
<th>Range</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>26</td>
<td>Channel 26</td>
<td>OUT</td>
<td>0-VSENS4</td>
<td>Sensor output</td>
</tr>
<tr>
<td>27</td>
<td>Channel 27</td>
<td>OUT</td>
<td>0-VSENS4</td>
<td>Sensor output</td>
</tr>
<tr>
<td>28</td>
<td>Channel 28</td>
<td>OUT</td>
<td>0-VSENS4</td>
<td>Sensor output</td>
</tr>
<tr>
<td>29</td>
<td>Private CAN+</td>
<td>IN</td>
<td></td>
<td>No internal connection</td>
</tr>
<tr>
<td>30</td>
<td>Private CAN-</td>
<td>IN</td>
<td></td>
<td>No internal connection</td>
</tr>
<tr>
<td>31</td>
<td>Private CAN Shield</td>
<td>IN</td>
<td></td>
<td>No internal connection</td>
</tr>
<tr>
<td>32</td>
<td>Public J1939+</td>
<td>I/O</td>
<td></td>
<td>LUIS control / monitor datalink</td>
</tr>
<tr>
<td>33</td>
<td>Public J1939-</td>
<td>I/O</td>
<td></td>
<td>LUIS control / monitor datalink</td>
</tr>
<tr>
<td>34</td>
<td>Public J1939 Shield</td>
<td>IN</td>
<td></td>
<td>LUIS control / monitor datalink</td>
</tr>
<tr>
<td>35</td>
<td>Ground</td>
<td>OUT</td>
<td></td>
<td>Sensor output</td>
</tr>
<tr>
<td>36</td>
<td>Ground</td>
<td>OUT</td>
<td></td>
<td>Sensor output</td>
</tr>
<tr>
<td>37</td>
<td>Ground</td>
<td>OUT</td>
<td></td>
<td>Sensor output</td>
</tr>
<tr>
<td>38</td>
<td>Ground</td>
<td>OUT</td>
<td></td>
<td>Sensor output</td>
</tr>
<tr>
<td>39</td>
<td>Ground</td>
<td>OUT</td>
<td></td>
<td>Sensor output</td>
</tr>
<tr>
<td>40</td>
<td>VSENS5</td>
<td>IN</td>
<td>0-5.5v</td>
<td>Sensor Supply for Channel 29-32</td>
</tr>
<tr>
<td>41</td>
<td>VSENS4</td>
<td>IN</td>
<td>0-5.5v</td>
<td>Sensor Supply for Channel 25-28</td>
</tr>
<tr>
<td>42</td>
<td>VSENS3</td>
<td>IN</td>
<td>0-5.5v</td>
<td>Sensor Supply for Channel 21-24</td>
</tr>
<tr>
<td>43</td>
<td>VSENS2</td>
<td>IN</td>
<td>0-5.5v</td>
<td>Sensor Supply for Channel 17-20</td>
</tr>
<tr>
<td>44</td>
<td>VSENS1</td>
<td>IN</td>
<td>0-5.5v</td>
<td>Sensor Supply for Channel 15-16</td>
</tr>
<tr>
<td>45</td>
<td>Channel 16A</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>46</td>
<td>Channel 17A</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>47</td>
<td>Channel 32</td>
<td>OUT</td>
<td>0-VSENS5</td>
<td></td>
</tr>
<tr>
<td>48</td>
<td>Channel 31</td>
<td>OUT</td>
<td>0-VSENS5</td>
<td></td>
</tr>
<tr>
<td>49</td>
<td>Channel 30</td>
<td>OUT</td>
<td>0-VSENS5</td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>Channel 29</td>
<td>OUT</td>
<td>0-VSENS5</td>
<td></td>
</tr>
</tbody>
</table>
**Connector Pinout – Parent/Child 1/Child 2/ 50 Pin Key 03**

This table gives the connector pinout for Parent/Child 1/Child 2/50 Pin Key 03.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
<th>I/O</th>
<th>Range</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Switch 1</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>2</td>
<td>Switch 2</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>3</td>
<td>Switch 3</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>4</td>
<td>Switch 4</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>5</td>
<td>Switch 5</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>6</td>
<td>Switch 6</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>7</td>
<td>Switch 7</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>8</td>
<td>Switch 8</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>9</td>
<td>Switch 9</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>10</td>
<td>Switch 10</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>11</td>
<td>Switch 11</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>12</td>
<td>Switch 12</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>13</td>
<td>Switch 13</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>14</td>
<td>Switch 14</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>15</td>
<td>Switch 15</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>16</td>
<td>Switch 16</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>17</td>
<td>Switch 17</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>18</td>
<td>Switch 18</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>19</td>
<td>Switch 19</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>20</td>
<td>Switch 20</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>21</td>
<td>Switch 21</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>22</td>
<td>Switch 22</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>23</td>
<td>Switch 23</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>24</td>
<td>Switch 24</td>
<td>OUT</td>
<td>Open-Ground</td>
<td>Low Side Switch output</td>
</tr>
<tr>
<td>25</td>
<td>Wavemaker Ch 6+</td>
<td>OUT</td>
<td>+/- 8V</td>
<td>Wavemaker Freq output Channel 6 (requires optional card)</td>
</tr>
<tr>
<td>26</td>
<td>Switch 25 Drain</td>
<td>I/O</td>
<td>0-24v</td>
<td>+V for High Side Switch, SW 25 Output for Low Side Switch</td>
</tr>
<tr>
<td>27</td>
<td>Switch 25 Source</td>
<td>I/O</td>
<td>0-24v</td>
<td>GND for Low Side Switch, SW 25 Output for High Side Switch</td>
</tr>
<tr>
<td>28</td>
<td>Switch 26 Drain</td>
<td>I/O</td>
<td>0-24v</td>
<td>+V for High Side Switch, SW 26 Output for Low Side Switch</td>
</tr>
</tbody>
</table>

*Continued on next page*
## Connector Pinout – Parent/Child 1/Child 2/ 50 Pin Key 03, Continued

This table continues to give the connector pinout for Parent/Child 1/Child 2/50 Pin Key 03.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
<th>I/O</th>
<th>Range</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>29</td>
<td>Switch 26 Source</td>
<td>I/O</td>
<td>0-24v</td>
<td>GND for Low Side Switch, SW 26 Output for High Side Switch</td>
</tr>
<tr>
<td>30</td>
<td>Switch 27 Drain</td>
<td>I/O</td>
<td>0-24v</td>
<td>+V for High Side Switch, SW 27 Output for Low Side Switch</td>
</tr>
<tr>
<td>31</td>
<td>Switch 27 Source</td>
<td>I/O</td>
<td>0-24v</td>
<td>GND for Low Side Switch, SW 27 Output for High Side Switch</td>
</tr>
<tr>
<td>32</td>
<td>Switch 28 Drain</td>
<td>I/O</td>
<td>0-24v</td>
<td>+V for High Side Switch, SW 28 Output for Low Side Switch</td>
</tr>
<tr>
<td>33</td>
<td>Switch 28 Source</td>
<td>I/O</td>
<td>0-24v</td>
<td>GND for Low Side Switch, SW 28 Output for High Side Switch</td>
</tr>
<tr>
<td>34</td>
<td>Switch 29 Drain</td>
<td>I/O</td>
<td>0-24v</td>
<td>+V for High Side Switch, SW 29 Output for Low Side Switch</td>
</tr>
<tr>
<td>35</td>
<td>Switch 29 Source</td>
<td>I/O</td>
<td>0-24v</td>
<td>GND for Low Side Switch, SW 29 Output for High Side Switch</td>
</tr>
<tr>
<td>36</td>
<td>Switch 30 Drain</td>
<td>I/O</td>
<td>0-24v</td>
<td>+V for High Side Switch, SW 30 Output for Low Side Switch</td>
</tr>
<tr>
<td>37</td>
<td>Switch 30 Source</td>
<td>I/O</td>
<td>0-24v</td>
<td>GND for Low Side Switch, SW 30 Output for High Side Switch</td>
</tr>
<tr>
<td>38</td>
<td>Wavemaker Ch 8+</td>
<td>OUT</td>
<td>+/- 8V</td>
<td>Wavemaker Freq output Channel 8 (requires optional card)</td>
</tr>
<tr>
<td>39</td>
<td>Wavemaker Ch 7+</td>
<td>OUT</td>
<td>+/- 8V</td>
<td>Wavemaker Freq output Channel 7 (requires optional card)</td>
</tr>
<tr>
<td>40</td>
<td>Key Switch</td>
<td>OUT</td>
<td>Open - VBATT</td>
<td>Key switch Output (relay contacts)</td>
</tr>
<tr>
<td>41</td>
<td>Engine Speed +</td>
<td>OUT</td>
<td>+/- 8V</td>
<td>Wavemaker Ch 1 output (arb. card)</td>
</tr>
<tr>
<td>42</td>
<td>Engine Speed -</td>
<td>OUT</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>43</td>
<td>Engine Position +</td>
<td>OUT</td>
<td>+/- 8V</td>
<td>Wavemaker Ch 2 output (arb. card)</td>
</tr>
<tr>
<td>44</td>
<td>Engine Position -</td>
<td>OUT</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>Wavemaker Ch 3+</td>
<td>OUT</td>
<td>+/- 8V</td>
<td>Wavemaker Ch 3 output (digital card)</td>
</tr>
<tr>
<td>46</td>
<td>Ground</td>
<td>OUT</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>Wavemaker Ch 4+</td>
<td>OUT</td>
<td>+/- 8V</td>
<td>Wavemaker Ch 4 output (digital card)</td>
</tr>
<tr>
<td>48</td>
<td>Ground</td>
<td>OUT</td>
<td>Ground</td>
<td></td>
</tr>
<tr>
<td>49</td>
<td>Wavemaker Ch 5+</td>
<td>OUT</td>
<td>+/- 8V</td>
<td>Wavemaker Ch 5 output (digital card)</td>
</tr>
<tr>
<td>50</td>
<td>Ground</td>
<td>OUT</td>
<td>Ground</td>
<td></td>
</tr>
</tbody>
</table>
## Connector Pinout – Sidecar 50 Pin Key 04

This table gives the connector pinout for Sidecar 50 Pin Key 04.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
<th>I/O</th>
<th>Range</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Channel 1</td>
<td>OUT</td>
<td>0-VSENS1</td>
<td>Sensor output</td>
</tr>
<tr>
<td>2</td>
<td>Channel 2</td>
<td>OUT</td>
<td>0-VSENS1</td>
<td>Sensor output</td>
</tr>
<tr>
<td>3</td>
<td>Channel 3</td>
<td>OUT</td>
<td>0-VSENS1</td>
<td>Sensor output</td>
</tr>
<tr>
<td>4</td>
<td>Channel 4</td>
<td>OUT</td>
<td>0-VSENS1</td>
<td>Sensor output</td>
</tr>
<tr>
<td>5</td>
<td>Channel 5</td>
<td>OUT</td>
<td>0-VSENS2</td>
<td>Sensor output</td>
</tr>
<tr>
<td>6</td>
<td>Channel 6</td>
<td>OUT</td>
<td>0-VSENS2</td>
<td>Sensor output</td>
</tr>
<tr>
<td>7</td>
<td>Channel 7</td>
<td>OUT</td>
<td>0-VSENS2</td>
<td>Sensor output</td>
</tr>
<tr>
<td>8</td>
<td>Channel 8</td>
<td>OUT</td>
<td>0-VSENS2</td>
<td>Sensor output</td>
</tr>
<tr>
<td>9</td>
<td>Channel 1</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>10</td>
<td>Channel 2</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>11</td>
<td>Channel 3</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>12</td>
<td>Channel 4</td>
<td>OUT</td>
<td>0-?</td>
<td>Open collector output (requires external pullup)</td>
</tr>
<tr>
<td>13</td>
<td>Channel 5</td>
<td>OUT</td>
<td>0-?</td>
<td>Thermocouple output</td>
</tr>
<tr>
<td>14</td>
<td>Channel 6</td>
<td>OUT</td>
<td>0-?</td>
<td>Thermocouple output</td>
</tr>
<tr>
<td>15</td>
<td>Channel 7</td>
<td>OUT</td>
<td>0-?</td>
<td>Thermocouple output</td>
</tr>
<tr>
<td>16</td>
<td>Channel 8</td>
<td>OUT</td>
<td>0-?</td>
<td>Thermocouple output</td>
</tr>
<tr>
<td>17</td>
<td>Ref1</td>
<td>IN</td>
<td>0-32v</td>
<td>Sensor Supply for Channel 9</td>
</tr>
<tr>
<td>18</td>
<td>Ref2</td>
<td>IN</td>
<td>0-32v</td>
<td>Sensor Supply for Channel 10</td>
</tr>
<tr>
<td>19</td>
<td>Ref3</td>
<td>IN</td>
<td>0-32v</td>
<td>Sensor Supply for Channel 11</td>
</tr>
<tr>
<td>20</td>
<td>Ref4</td>
<td>IN</td>
<td>0-32v</td>
<td>Sensor Supply for Channel 12</td>
</tr>
<tr>
<td>21</td>
<td>Channel 9</td>
<td>OUT</td>
<td>0-Ref1</td>
<td>Sensor output</td>
</tr>
<tr>
<td>22</td>
<td>Channel 10</td>
<td>OUT</td>
<td>0-Ref2</td>
<td>Sensor output</td>
</tr>
<tr>
<td>23</td>
<td>Channel 11</td>
<td>OUT</td>
<td>0-Ref3</td>
<td>Sensor output</td>
</tr>
<tr>
<td>24</td>
<td>Channel 12</td>
<td>OUT</td>
<td>0-Ref4</td>
<td>Sensor output</td>
</tr>
<tr>
<td>25</td>
<td>N/C</td>
<td></td>
<td></td>
<td>Not used</td>
</tr>
<tr>
<td>26</td>
<td>SW 1 Contact</td>
<td>I/O</td>
<td>N/O</td>
<td>Normally Open Contact</td>
</tr>
<tr>
<td>27</td>
<td>SW 2 Contact</td>
<td>I/O</td>
<td>N/O</td>
<td>Normally Open Contact</td>
</tr>
<tr>
<td>28</td>
<td>SW 3 Contact</td>
<td>I/O</td>
<td>N/O</td>
<td>Normally Open Contact</td>
</tr>
</tbody>
</table>

Continued on next page
This table continues to give the connector pinout for Sidecar 50 Pin Key 04.

<table>
<thead>
<tr>
<th>Pin</th>
<th>Function</th>
<th>I/O</th>
<th>Range</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>29</td>
<td>SW 4 Contact</td>
<td>I/O</td>
<td>N/O</td>
<td>Normally Open Contact</td>
</tr>
<tr>
<td>30</td>
<td>SW 5 Contact</td>
<td>I/O</td>
<td>N/O</td>
<td>Normally Open Contact</td>
</tr>
<tr>
<td>31</td>
<td>N/C</td>
<td></td>
<td></td>
<td>Not used</td>
</tr>
<tr>
<td>32</td>
<td>SW 7 Contact</td>
<td>I/O</td>
<td>N/O</td>
<td>Normally Open Contact</td>
</tr>
<tr>
<td>33</td>
<td>SW 8 Contact</td>
<td>I/O</td>
<td>N/O</td>
<td>Normally Open Contact</td>
</tr>
<tr>
<td>34</td>
<td>SW 1 Contact</td>
<td>I/O</td>
<td>N/C</td>
<td>Normally Closed Contact</td>
</tr>
<tr>
<td>35</td>
<td>SW 2 Contact</td>
<td>I/O</td>
<td>N/C</td>
<td>Normally Closed Contact</td>
</tr>
<tr>
<td>36</td>
<td>SW 3 Contact</td>
<td>I/O</td>
<td>N/C</td>
<td>Normally Closed Contact</td>
</tr>
<tr>
<td>37</td>
<td>SW 4 Contact</td>
<td>I/O</td>
<td>N/C</td>
<td>Normally Closed Contact</td>
</tr>
<tr>
<td>38</td>
<td>SW 5 Contact</td>
<td>I/O</td>
<td>N/C</td>
<td>Normally Closed Contact</td>
</tr>
<tr>
<td>39</td>
<td>N/C</td>
<td></td>
<td></td>
<td>Not used</td>
</tr>
<tr>
<td>40</td>
<td>SW 7 Contact</td>
<td>I/O</td>
<td>N/C</td>
<td>Normally Closed Contact</td>
</tr>
<tr>
<td>41</td>
<td>SW 8 Contact</td>
<td>I/O</td>
<td>N/C</td>
<td>Normally Closed Contact</td>
</tr>
<tr>
<td>42</td>
<td>Ground</td>
<td>OUT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>43</td>
<td>Ground</td>
<td>OUT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>44</td>
<td>Ground</td>
<td>OUT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>45</td>
<td>Ground</td>
<td>OUT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>46</td>
<td>Ground</td>
<td>OUT</td>
<td></td>
<td></td>
</tr>
<tr>
<td>47</td>
<td>Supply</td>
<td>OUT</td>
<td>5.5V</td>
<td>5.5V Power Supply</td>
</tr>
<tr>
<td>48</td>
<td>N/C</td>
<td></td>
<td></td>
<td>Not used</td>
</tr>
<tr>
<td>49</td>
<td>VSENS2</td>
<td>IN</td>
<td>0-5.5v</td>
<td>Sensor Supply for Channel 5-8</td>
</tr>
<tr>
<td>50</td>
<td>VSENS1</td>
<td>IN</td>
<td>0-5.5v</td>
<td>Sensor Supply for Channel 1-4</td>
</tr>
</tbody>
</table>
Section 8 – CAN Protocol

CAN Protocol

Introduction

The LUIS uses special formatted CAN commands to send data from the PC to the hardware. The CAN Baud rate is 250k and the LUIS hardware has no bus terminations resistors in the box. Proper bus termination must occur on external CAN nodes for correct operation.

CAN Protocol

All CAN communications from LUIS PC to LUIS hardware use the J1939 Proprietary A message. The following is the definition for this message.

Parameter Group Name: Proprietary A
Definition: This proprietary PG uses the Destination Specific PDU Format allowing manufacturers to direct their proprietary communications to a specific destination node. How the data field of this message is used is up to each manufacturer. Use of proprietary messages is at the manufacturer’s discretion with the constraint that significant percentages (2% or more) of vehicle network utilization must be avoided.

Transmission repetition rate: Per user requirements
Data length: 8 bytes
Data Page: 0
PDU Format: 239
PDU Specific: Destination Address: 0xF1 = Load Box PC Controller
0xF2 = Load Box Parent
0xF3 = Load Box Child 1
0xF4 = Load Box Child 2
0xF5 = Load Box Sidecar
0xF6 = Speed Board

Default priority: 6
Parameter Group Number: 61184 (00EF0016)

Continued on next page
CAN Protocol, Continued

**Command Byte**  The first byte in the 8 byte data message is the Command Byte. The following table lists all of the Commands available.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0x01</td>
<td>Switch Command</td>
</tr>
<tr>
<td>0x02</td>
<td>DAC Command</td>
</tr>
<tr>
<td>0x04</td>
<td>Power Up Message</td>
</tr>
<tr>
<td>0x05</td>
<td>Reset</td>
</tr>
<tr>
<td>0x06</td>
<td>Status Request/Response</td>
</tr>
<tr>
<td>0x07</td>
<td>Calibration Request/Response</td>
</tr>
<tr>
<td>0x50</td>
<td>Change Signal Frequency</td>
</tr>
<tr>
<td>0x51</td>
<td>Freq Output Channel Configuration</td>
</tr>
<tr>
<td>0x59</td>
<td>Engine Model</td>
</tr>
</tbody>
</table>

*Continued on next page*
CAN Protocol, Continued

Switch Command

One message updates all of the switches per load box. All of the switches are mapped to a specific bit in the switch command message. The following table depicts the location of the switch bit within the switch message.

**Switch Command** – Defines ON/OFF state of each LUIS switch.

- **Data Length:** Command (0x01) + 4 bytes
- **Resolution:** 1 switch per bit (0 = OFF, 1 = ON)
- **Data Range:** 0 to 0xFFFF FFFF
- **Type:** Status

<table>
<thead>
<tr>
<th>Switch Name</th>
<th>Function</th>
<th>Byte</th>
<th>Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW31</td>
<td>Harness defined HS or LS</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>SW30</td>
<td>Harness defined HS or LS</td>
<td>2</td>
<td>2</td>
</tr>
<tr>
<td>SW29</td>
<td>Harness defined HS or LS</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>SW28</td>
<td>Harness defined HS or LS</td>
<td>2</td>
<td>4</td>
</tr>
<tr>
<td>SW27</td>
<td>Harness defined HS or LS</td>
<td>2</td>
<td>5</td>
</tr>
<tr>
<td>SW26</td>
<td>Harness defined HS or LS</td>
<td>2</td>
<td>6</td>
</tr>
<tr>
<td>SW25</td>
<td>Harness defined HS or LS</td>
<td>2</td>
<td>7</td>
</tr>
<tr>
<td>Keyswitch</td>
<td>Keyswitch</td>
<td>2</td>
<td>8</td>
</tr>
<tr>
<td>SW17</td>
<td>Switch to ground</td>
<td>3</td>
<td>1</td>
</tr>
<tr>
<td>SW18</td>
<td>Switch to ground</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>SW19</td>
<td>Switch to ground</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>SW20</td>
<td>Switch to ground</td>
<td>3</td>
<td>4</td>
</tr>
<tr>
<td>SW21</td>
<td>Switch to ground</td>
<td>3</td>
<td>5</td>
</tr>
<tr>
<td>SW22</td>
<td>Switch to ground</td>
<td>3</td>
<td>6</td>
</tr>
<tr>
<td>SW23</td>
<td>Switch to ground</td>
<td>3</td>
<td>7</td>
</tr>
<tr>
<td>SW24</td>
<td>Switch to ground</td>
<td>3</td>
<td>8</td>
</tr>
<tr>
<td>SW9</td>
<td>Switch to ground</td>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>SW10</td>
<td>Switch to ground</td>
<td>4</td>
<td>2</td>
</tr>
<tr>
<td>SW11</td>
<td>Switch to ground</td>
<td>4</td>
<td>3</td>
</tr>
<tr>
<td>SW12</td>
<td>Switch to ground</td>
<td>4</td>
<td>4</td>
</tr>
<tr>
<td>SW13</td>
<td>Switch to ground</td>
<td>4</td>
<td>5</td>
</tr>
<tr>
<td>SW14</td>
<td>Switch to ground</td>
<td>4</td>
<td>6</td>
</tr>
<tr>
<td>SW15</td>
<td>Switch to ground</td>
<td>4</td>
<td>7</td>
</tr>
<tr>
<td>SW16</td>
<td>Switch to ground</td>
<td>4</td>
<td>8</td>
</tr>
</tbody>
</table>

Continued on next page
The following table continues to depict the location of the switch bit within the switch message.

<table>
<thead>
<tr>
<th>Switch Name</th>
<th>Function</th>
<th>Byte</th>
<th>Bit</th>
</tr>
</thead>
<tbody>
<tr>
<td>SW1</td>
<td>Switch to ground</td>
<td>5</td>
<td>1</td>
</tr>
<tr>
<td>SW2</td>
<td>Switch to ground</td>
<td>5</td>
<td>2</td>
</tr>
<tr>
<td>SW3</td>
<td>Switch to ground</td>
<td>5</td>
<td>3</td>
</tr>
<tr>
<td>SW4</td>
<td>Switch to ground</td>
<td>5</td>
<td>4</td>
</tr>
<tr>
<td>SW5</td>
<td>Switch to ground</td>
<td>5</td>
<td>5</td>
</tr>
<tr>
<td>SW6</td>
<td>Switch to ground</td>
<td>5</td>
<td>6</td>
</tr>
<tr>
<td>SW7</td>
<td>Switch to ground</td>
<td>5</td>
<td>7</td>
</tr>
<tr>
<td>SW8</td>
<td>Switch to ground</td>
<td>5</td>
<td>8</td>
</tr>
</tbody>
</table>
**CAN Protocol, Continued**

**DAC Command**

This message updates one of the DAC channels. Byte 5 will hold the value until the Immediate update has been given or update it upon receipt.

**DAC Command** – Set DAC output voltage
- **Data Length:** Command (0x02) + 4 bytes
- **Resolution:** Byte 2; 1 channel per count
- Byte 3 & 4; 1 bit per count
- Byte 5; ON/OFF
- **Data Range:** Byte 2; 1-32 (SIG #)
- Bytes 3 & 4; 0 – 4095 counts
- Byte 5; 0x00 = Hold Value
- 0x01 = Immediate Update
- **Type:** Status

**HW Powered**

When the load box power cycles, this message is sent to inform the LUIS GUI that a new box has been powered up and it will then receive updated channel information based on the GUI settings.

**HW Powered UP** – Message sent from LUIS to PC after power cycle
- **Data Length:** 1 Byte (0x04)
- **Resolution:** HW has just been power-cycled.
- No response required from PC;
- If PC is listening, should refresh all outputs. If key switch is ON, PC should set it to OFF before refresh & warn user that HW was power-cycled & outputs refreshed, but Key is now OFF to prevent unexpected errors.
- **Data Range:** 0x04 only
- **Type:** Status

*Continued on next page*
CAN Protocol, Continued

**Reset Command**

The Reset command will reset all of the LUIS I/O and disable all of the DAC outputs.

- **Reset** – Turn off all switches and disable all DAC outputs
- **Data Length:** Command (0x05) + 1 Byte
- **Resolution:** N/A
- **Data Range:**
  - 0x01 = Soft Reset (all switches off, all DAC’s = 0v)
  - 0x03 = Hard Reset (jump to bootloader)
- **Type:** Status

**Status Request**

The Status Request is derived from the PC and sent every two seconds to ping the hardware and obtain information about the hardware.

- **Data Length:** Command (0x06) + 7 Bytes
- **Byte 2:** 0xFF (handshake)
- **Byte 3:** LUIS Firmware Major version (0-255)
- **Byte 4:** LUIS Firmware Minor version (0-255)
- **Byte 5:** Data Fresh
  - 0x00 = No Switch or DAC commands received since last power cycle
  - 0x01 = Switch and/or DAC commands have been executed since last power cycle
- **Byte 6:** Lamp feedback status
  - 1 bit per lamp, only 5 lamps to date.
  - 0 = OFF / 1 = ON
  - Bits 5-7 not used, set to 0.
- **Bytes 7-8 not used**

**Status Request Example:** 0x18EFF2F1 (all data bytes 2-8 set to 0xFF) (PC asking “is Parent out there?”)

**Status Response Example:** 0x18EFF1F2 0x06 0x01 0x02 0x00 0x00 0x00 0x00 (from Parent, firmware ver 1.2, no commands executed yet, all lamps OFF)

*Continued on next page*
### CAN Protocol, Continued

**Calibration Request**

The Calibration Request message will start the calibration procedure. Typically a unit under test is installed on the load box before the command is issued.

**Calibration Request** – Request from PC / Response of attached LUIS devices  
Data Length: Command (0x07) + 7 Bytes  
Resolution: N/A  
Data Range:  
- Byte 1; Calibrate option  
  - 0x01 = Calibrate all available channels  
  - 0x02 = Set calibration tables to default values  
  (this byte set to 0xFF in Response msg)  
- Byte 2; Calibration progress  
  Range 0-100 indicating percentage complete  
  Bytes 3-8 not used  

Type: Status

**Change Frequency**

Changes the signal output frequency or FOUT. Data values can be in Hertz or RPM depending on how the bit is set in the configuration message for that channel.

**Change Frequency** – Set the Frequency  
Data Length: Command (0x51) + 8 Bytes  
Resolution: Byte 3,4,5 RPM or Hz  
- Byte 6 Ramp in RPM or Hz  
Data Range:  
- Byte 2; Wavemaker Address  
- Byte 3,4,5; RPM or Hz  
- Byte 6; Ramp Rate  
  Bytes 7-8 not used  

Type: Status  

Bytes 3-5 are the Hertz or RPM values with Byte 5 representing the Low Byte.  
The Ramp rate is how fast the signal transitions from its current value to its new value. A Ramp of zero will set the output frequency/RPM as fast as the WaveMaker can transition the signal.  
If the Signal is setup for Frequency, all values above 2.5MHz will be ignored.

*Continued on next page*
CAN Protocol, Continued

The Configuration messages configures each channel in the Wavemaker hardware that inside of LUIS. The Wavemaker hardware is responsible for all of the frequency signal outputs of LUIS.

**Configuration Message** – Sent from the PC to Wavemaker

- **Data Length:** Command (0x51) + 8 Bytes
- **Resolution:** N/A
- **Data Range:**
  - Byte 2; Wavemaker Address
    - Low Nibble Channel Number
    - High Nibble Wavemaker Number
  - Byte 3; Waveform Number
    - See Waveforms Section
  - Byte 4; Sync w/Master Clock
    - 0x00 = No Sync with Master signal
    - 0x01 = Sync with Master signal
  - Byte 5,6; Offset from Master
  - Byte 7; Signal Technology
    - Low Nibble
      - 1 = Hall
      - 2 = VR
    - High Nibble
      - 1 = PWM, Bytes 5,6 HB Freq
  - Byte 8; Controls data bytes in command 0x50
    - Low Nibble
      - Number of Cycles
    - High Nibble
      - 1 = Frequency (Arbitrary Card)
      - 2 = RPM Values (Arbitrary Card)
      - 3 = Frequency (Digital Card)
      - 4 = RPM (Digital card, Bytes 5-6 used to set Teeth/Rev.)

**Type:** Status

*Continued on next page*
The Engine model command controls the Open/Closed loop model for LUIS. If the system is in Closed loop mode, engine speed on the GUI is controlled by the unit under test and cannot be changed by the user.

### Engine Model – Sent from the PC to LUIS

- **Data Length:** Command (0x59) + 8 Bytes
- **Resolution:** Byte 4-5; 1-100% Load, 0-1000 Gain
- **Data Range:** Byte 2; Wavemaker Address
  - High Nibble: Wavemaker Number
- **Byte 3; Model Command**
  - 1 = Open Loop Mode
  - 2 = Closed Loop Mode
  - 3 = Start Engine
  - 4 = Reset Model
  - 5 = % Load
  - 6 = Gain Adjust
  - 7 = Rate Limit
- **Byte 4-5; % Load or Gain**
- **Byte 6-8; Not Used**

<table>
<thead>
<tr>
<th>Type</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Section 9 – Multi-Parent Setup

Multi-Parent Setup

Introduction

The LUIS Parent unit has a number of features that the Child boxes do not have. The Child boxes are a scaled down Parent to save costs since some of the additional I/O of the Parent is not needed for the Multi-Module setup (Wavemaker, loads, and internal power supply). The typical Multi-Module setup involves one Parent and multiple Child units. These systems are stacked into a special made rack assembly. The Parent units can be connected as Child units if special cables and LUIS configuration files are used. Since the Parent unit has addition features, having multiple Parent units will conflict with each other unless these cables are used. The following describes how to connect multiple Parents together to make a Multi-Module system.

Required Cables

A set of specialized cables (PN G01244-00) can be obtained from GarTech Enterprises Inc. to connect multiple Parents together to make a multi-module setup. The cables consist of Power, I/O rerouting, and CAN connections. The Power connections simply jumper power from one box to another. The I/O rerouting cable breaks into the I/O cables from LUIS to the ECM and makes connections that need to go to all of the LUIS boxes, for example speed signal connections and keyswitch. The CAN jumpers connect all of the CAN busses together so proper communications will occur with all of the modules. The following picture depicts the required cables:
**Multi-Parent Setup, Continued**

**Power Connections**

The Power connections for the three Parents must be chained together. Using the power cables supplied in the kit, connect the 4 pin connector into the Parent power connector and plug the other end into Child 1’s red and black banana jacks connections. Use another provided power cable and connect the 4 pin connector into the Child 1 power connection and the other end of the cable into the Child 2 red and black banana jacks. See the following figure. The Parent unit is on the left, Child 1 is in the middle, and Child 2 is on the right.

![Power Connections](image1)

**Private CAN Connections**

The Private CAN datalinks must be chained together so the ECM’s can communicate together. Following the labels on the cable, plug all three of these connections into the load boxes. See the following figure.

![Private CAN Connections](image2)

*Continued on next page*
Multi-Parent Setup, Continued

Public CAN Connections

The Public CANdatalinks must be chained together so the LUIS GUI can send data to each unit. Notice there is a loose connector on the left end of the picture which is used to connect the LUIS PC to the system. The Sidecar-to-Parent Jumpers must also be in place. Following the labels on the cables, plug all three connections in as shown.

Special I/O Connections

There are a few I/O items that need to be chained directly from the cables that connect LUIS to the ECM. These connections are clearly marked and have a 6 pin Deutsch connector to join them together. On the Child 1 and Child 2 cables, the 6 pin connector will have to be disconnected and then reconnected into the provided cables.

Continued on next page
**Multi-Parent Setup, Continued**

**All Connections**

The following figure shows all of the connections needed to make Parent units function for Multi-Module setups.